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Testing to Make Sure that you can Join a WebEx Session 
1. Open up the web browser that you will be using for the WebEx sessions.  

2. Type the following URL into your browser:  http://www.webex.com/lp/jointest/ 

3. If you had success in getting into the URL, then proceed to the steps for “Joining the 

WebEx Meeting.” If you were not successful in getting into the URL, then contact: 

t3online@ti.com 

 

 

Joining the WebEx Meeting 
1. Click on the meeting link that was sent to you. 

2. Once you are in the WebEx Meeting Center, type your name and email address in the 

space provided and click “Join.” 
 

3. An “Audio Conference” pop up screen will appear and will direct you to either call in to 

the meeting or to use your computer to call into the meeting. It is NOT advised to call 

in using the microphone built into your computer! 
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4. If you are calling into the meeting using a headset connected to your computer, select 

“Call Using Computer” and follow the steps below titled “Testing Audio.” 

5. If you are calling into the meeting using your phone, click on the arrow to the left of “Use Phone.” 

 

6. Dial the number on the screen. When prompted, type in the access code and press the # key. 

Finally, when prompted, enter your Attendee ID and press the # key. 
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Testing Audio  

1. Once you are connected via your computer to WebEx, select the “Audio” tab at the top 

of the page. 

 

 

2. Select “Speaker/Microphone Audio Test” to check your audio settings. 

 

 
 
3. Select the “Test” button in the “Speaker” box. Adjust the bar to an appropriate level. 

 

 
 
4. In the “Microphone box,” speak into your microphone and adjust the volume until the green bar 

moves into the appropriate range. If needed, uncheck the “automatically adjust volume” box. 

5. Once the speaker and microphone have both been adjusted appropriately, select “Ok.” 
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Useful Participant Features of WebEx 
1. On the right side of your screen, you will find the following panels:  participant list, raise hand, chat, 

& notes.  Note: one of these panels might be hidden. To unhide a panel, click the name of that 

panel at the top of the page. 

 

 

 
 

2. To mute or un-mute yourself, press on the “microphone” icon to the right of your name. 
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3. To raise your hand to ask a question or to participate, click the “raise hand” icon below the names 

of the participants. Be sure to press the “raise hand” icon again when you are done asking a 

question or participating. 

 

 
 
4. To send a chat (comments, questions, concerns, etc.), first select the person(s) that you want to 

send a message to, type something in the chat box, and press “Send.” 
 

 
 
5. To take notes during the session, click the “Notes” field, start typing, and click “Save.” 
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Viewing the Chat Window During a Shared Desktop 
 
1. At the top of the screen, hover over the WebEx Meeting Center toolbox. 
 

 
 
2. Select the “Chat” icon. 
 

 
 
3. This will open up the chat window on the right side of your screen. 
 
 
For Additional WebEx Support, visit:  
http://university.webex.com/training/student/content/welcome.doc 
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Activity Overview: 
In this activity you will become familiar with the most commonly used keys on the TI-Nspire™ CX and  
TI-Nspire™ CX CAS handhelds. 
 
 

 
 
 
 

10  

9 

1 2 3 

4 

5 8 

6 7 

11



 The Calculator Application                                TEACHER NOTES 
                 TI PROFESSIONAL DEVELOPMENT 
 

 

©2011 Texas Instruments Incorporated 1 education.ti.com 

 

Activity Overview: 
This activity explores various menus and templates available in the Calculator application. 
 
 
 

Step 1: 

Open a New Document and add a Calculator application. If you are on the Home screen, select Current 

to return to the document with the Calculator application. 

Step 2: 

Press t to access the templates. Select the first option on the first 

row for the fraction template. Practice adding and subtracting 

fractions. 

Note: You can also press / p to access the fraction 

template. Use the Touchpad arrow keys or press e to 

move from numerator to denominator. 

Note: To find the decimal value (usually displayed at a maximum 

of 6 digits), press / ·. 

Step 3: 

Enter another fraction problem and add a decimal after any 

numerator or denominator to find the decimal value. 

 

Step 4: 

To convert the last answer from a decimal back into a fraction, select 

Menu > Number > Approximate to Fraction, and press ·. 

Note:  The value within the parentheses is the tolerance for this 

command. 
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Step 5: 

Find the factors of 240 by selecting Menu > Number > Factor.  

Note: The Least Common Multiple and Greatest Common 

Divisor commands are also located in the Number menu.  

 

Step 6: 

To raise a number to a power, first enter the base. Press l, and 

enter the exponent. Press ·. 

Note: The cursor is still in the exponent box after the exponent 
has been entered. If a further calculation is needed, press ¢ 

to exit the exponent box. 

Note: Pressing t and selecting the second option in the first 

row will also access the exponent template. 

Step 7: 

To determine a root, press / q for the square root or / l for the nth root. 

Note: Use the root template, and then explore some of the other templates. 

Step 8: 

To check the truth value of a statement, enter the statement, and then 
press ·. 

Note: To access the inequality symbols, press / =. 

Step 9: 

To evaluate a trigonometric ratio in degrees without changing to 
degree mode: 

 Press μ to access the trigonometric ratios, and then 

select the required ratio. 

 After entering the angle to be evaluated, press / k to 

access the symbol palette. 

 Select the degree symbol and press ·. 
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Step 10: 

To copy and paste a previous line that you would like to edit, press £ 
until the line is highlighted and press · to paste the desired line 

into the current line. Edit the line as needed and press · to 

execute the line. 

Step 11: 

To check an equation or to evaluate an expression, use the “such 
that” key by pressing / =.  

 

 

 

 

Note: To access the braces, press / ). 

 

Step 12: 

To store a value to a variable, enter the value and press / h 

and then the name of the variable; then press ·.  

Step 13: 

You can use the stored value by typing the name of the variable when 

you are performing a calculation. 

Step 14: 

The xx/99 in the lower-right corner of the screen is the number of 
lines in the history of the calculator application that have been 

executed. To clear the calculator screen, select Menu > Actions > 
Clear History. 

\ 

 
 

14



 The Graphs Application—Part One                         Teacher Notes                                   
TI Professional Development                         

 

 

©2011 Texas Instruments Incorporated 1 education.ti.com 

Activity Overview: 
In this activity, you will graph a function, display a table of values for a function, and transform a function. 
 
 
 

Part One—Graphing a Linear Function and Displaying a Table 

Step 1: 

Press c, and select New Document to start a new document.   

Step 2: 

Choose Add Graphs. 

Note: To add a new Graphs page to an existing document, press 

/ ~ and choose Add Graphs. Alternatively, press c and 

select . 

  

Step 3:  

The cursor will be in the entry line at the bottom of the screen, to the 

right of “f1(x) =”. To graph f1(x) = 3x – 2, type in 3x – 2 by pressing 

3 X - 2.  

Teacher Tip: Before they press ·, ask students to 

predict the shape of the graph. 

Press · to graph.  

Note: If desired, the function definition (label) may be moved to 

another location on the screen. Move the cursor to hover over the 

function label. When the word label appears, you may use the 

Touchpad to move the label. Press x or · to “drop” the label. 

 

Step 4:  

To insert a table of values, press / T. The table will be inserted 

to the right of the graph. You can navigate within the table to view the 

values of each function for a specific x-value. 

Note: The dark rectangle around the table indicates that the 

application is active. To move from one application work area to 

another, press / e or use the Touchpad and press x to select 

the desired application. 
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Step 5:  

To change the table settings, press Menu > Table > Edit Table 

Settings. Edit the settings, as desired, and press · or click OK 

when done. 

Step 6:     

To hide the table, first click on the Graphs application side of the page 

to select that application. Then, press / T to hide the table. 

Alternatively, in the Graphs application, press Menu > View > Hide 

Table. 

 

 

Part Two – Transforming a Linear Function 

Step 1: 

Using the Touchpad, move the cursor near the graph of the function. 

As the cursor moves toward certain regions of the graph of a linear 

function, two different tools—the Rotation tool and the Translation 

tool—may be displayed.  

To rotate the line, move the cursor to the graph of the line near the 

edge of the graph screen. When the rotation symbol (é) appears, 

press / x to grab the line. Use the Touchpad to rotate the graph. 

When finished, press x or d. 
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Step 2: 

To translate the line, move the cursor to the graph of the line in the 

center of the screen. When the translation symbol (ö) appears, press 

/ x to grab the line. Use the Touchpad to translate the graph. 

When finished, press x or d. 
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Activity Overview: 
In this activity, you will graph two functions and explore various methods for finding points  
of intersection. 
 
 
 

Part One: Graphing Two Linear Functions and Finding the Point of Intersection by 
Tracing on the Graph of the Functions 

Step 1: 

Press c and select New Document to start a new 

document. 

 

 

Step 2: 

Choose Add Graphs. 

Note: To add a new Graphs page to an existing document, 

press / ~ and choose Add Graphs. Alternatively, you 

can press c and select . 

  

Step 3: 

The cursor will be in the entry line at the bottom of the screen 

to the right of f1(x) =. To graph f1(x) = –2x – 1, press v 2 X 

- 1, and then press ·. 

 

 

Step 4: 

To graph f2(x) = 0.5x + 4, first press e to view the entry line. 

(Alternatively, press / G or click on the chevron to display 

the entry line.)  

The cursor will now be to the right of f2(x) =. Press ^ 5 X 

+ 4, and then press · to graph the function. 

Note: To graph multiple functions without closing the entry line, 

press ¤ after entering a function definition. After entering the 

last function definition, press ·. 
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Step 5: 

Drag the function label for f1(x) to the lower-left side of the 

screen.  

Note: This function label is moved to prepare for Step 6. When 

Trace is selected, the coordinates of the trace point(s) will be 

displayed in the lower right corner of the screen.   

Step 6: 

To trace and display function values for multiple graphed 

functions, press Menu > Trace >Trace All. 

To trace on the functions, press the left or right arrow key on 

the Touchpad. 

 

Step 7: 

When the Trace tool is active, function values for a particular 

value of x may be displayed. Type a value for x (the number 1 

was chosen for this example) and then press · to display 

the function values at that value of x. 

 

Note: If a value for x outside of the window settings is entered 

while tracing, the window will readjust for that particular  

x-value. The minimum and maximum y-values for the window 

may need to be adjusted. 
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Step 8: 

To change the trace step, press Menu > Trace >Trace Step. 

Press the arrow to the right of the word Automatic and select 

Enter Value. Enter a value for Trace Step (0.25 for this 

example) and then press ·. 

Note: When tracing after the trace step has been changed, the 

first value displayed for x will be the current x-value plus or 

minus the trace step. To change the x-value, follow the steps 

described in Step 7. Then, continue to trace. 

 

 

Step 9: 

Trace until the point of intersection is located. 

To exit the Trace tool, press d. 

 

 

Part Two Finding Points of Intersection Using the Intersection Point(s) Tool 

 

Step 10: 

Press / I or / ~ to insert a new page in the 

document. Select Add Graphs. Note that this is page 1.2—

problem 1, page 2. 

 

 

Step 11: 

Graph any two linear functions whose point of intersection will 

be displayed in the current window. Move the function labels, 

as needed. 

Note: The entry line displays f3(x) = since f3 is the next 

available function in this problem.  
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Step 12: 

Press Menu > Points & Lines > Intersection Point(s). Using 

the Touchpad, move the Pointer tool to the graph of one of the 

functions, and press x to select the function. Move the 

Pointer tool to the second function and press x to select the 

second function.  
 

The point of intersection and its coordinates are displayed. 

To exit the Intersection Point(s) tool, press d. 

 

Note: Use Points & Lines > Intersection Point(s) to 

determine multiple intersection points. After the functions are 

graphed, press Menu > Points & Lines > Intersection 

Point(s). Press x to select the graph of one of the functions. 

Move the Pointer tool to the second graph and press x to 

select the second function. Both intersection points as well as 

the coordinates are displayed. 

 

 

Part Three: Finding a Point of Intersection Using the Analyze Graph Menu 

Step 13: 

Press / I or / ~ to insert a new page in the 

document. Select Add Graphs. 

 

 

Step 14: 

Graph any two functions whose point of intersection will be 
displayed in the current window. Move the function labels, as 
needed. 
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Step 15: 

Press Menu > Analyze Graph > Intersection. 

 

 

Step 16: 

Set the lower bound by moving the Pointer tool to the left of 

the point of intersection. The message “lower bound?” is 

displayed.  

Press x to set the lower bound.  

  

To set the upper bound, first move the pointer to the right of the 

intersection point. The point of intersection will appear if the 

upper bound is to the right of the intersection point. 

Press x to set the upper bound. 
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Activity Overview: 
This activity describes how to graph a system of inequalities.  
 
 
 
 

Step 1: Press c and select New Document to start a new document.   

 

Step 2: Select Add Graphs. 

 

 

Step 3: The cursor will be in the entry line at the bottom of the 

screen to the right of f1(x) =. Press . to delete the 

equals sign. When the equals sign is deleted, a dialog box 

appears with inequality symbols and the equals sign.  

 

 
 

Step 4: Select > from the dialog box by pressing 4 or use the 

Touchpad to highlight that option, and press ·. 

Note: When an inequality symbol is selected, f1(x) changes to y 

since a relationship is to be graphed rather than a function. 

 

Step 5: Press X + 1 and then press · to view the graph of 

the inequality y > x + 1.  

If the inequality label is not displayed, move the cursor near 

the edge of the graph. When the word graph is displayed, 

press / b and select Label.  

 

 

 

 

 

23



 Graphing an Inequality                              TEACHER NOTES 

TI PROFESSIONAL DEVELOPMENT 
 

 

©2011 Texas Instruments Incorporated 2 education.ti.com 
 

Step 6: Press e or / G to display the entry line. The cursor 

will be positioned to the right of f1(x) =. 

Step 7: Press . to delete the equals sign. Select ≤  from the 

dialog box by pressing 1 or ·. 

 

 

Step 8:  Press v X q + 4 and then press · to view the 

graph of the inequality y ≤ –x2 + 4. 

If the graph label is not displayed, follow the directions in 

Step 5 to add the label. Move the label, if desired. 

 

 

 

 

 

Note: To view the list of inequalities graphed, press e or  

/ G to display the entry line. Press £ on the Touchpad to 

locate the inequality. If desired, edit the inequality and press · 
to graph. Otherwise, press / G to close the entry line. 

 

 

The entry line may also be displayed by clicking on the chevron in 

the lower left corner of the screen. 
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Open the TI-Nspire™ document 

Modeling_with_a_Quadratic_Function.tns. 

 

You will determine the equation of a quadratic function that models 

the path of a basketball. Based on your equation, you will solve 

problems related to the path of the basketball. 

  

 

Move to page 1.2. 

 

Note: Two tick marks represent 1 meter. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

1. Graph the parent quadratic function, f(x) = x2, on page 1.2. Transform the parent 

function so that it matches the path of the basketball. What is the equation of the 

quadratic function that matches the path of the basketball? 

 

Note: You may need to drag the function definition away from the graph in order to 

transform the parabola. 

 

2. In this activity, the horizontal distance traveled by the basketball is the independent 

variable. What is the dependent variable? 

 
 

3. Determine the maximum height of the basketball in meters. Explain your reasoning. 

 

 

4. Visualize a point on the ground directly beneath the ball when it reaches its maximum height. 

How far is this point from the person shooting the basketball? Explain your reasoning. 

 

 

5. How high was the ball when it was a horizontal distance of 2 m from the person 

shooting the basketball? Explain your reasoning. 

 

 

6. If the ball followed the path modeled by your quadratic function and the basket was not 

there, how far would it have landed from the person on the left? Explain your 

reasoning. 
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Math Objectives 
• Students will model a basketball’s flight through the air using a 

quadratic function. 

• Students will analyze their quadratic function and interpret the 

parameters of the function in relation to the flight path of the 

basketball. 

• Students will reason abstractly and quantitatively. (CCSS 

Mathematical Practice) 

 

Vocabulary 
• Parent quadratic function 

• Maximum value of a quadratic function 

• Zero of a quadratic function 

 

About the Lesson 
• In this lesson, students use a quadratic function to model the 

flight path of a basketball. Students will interpret the parameters 

of the quadratic model to answer questions related to the path of 

the basketball. 

• As a result, students will: 

• Model data with quadratic functions 

• Interpret the vertex of a quadratic function in a real-world 

context 

• Determine a zero of a quadratic equation. 

• Use a mathematical model to make predictions. 

 

TI-Nspire™ Navigator™ System 
• Use Screen Capture to compare students’ graphs when they fit a 

quadratic function. 

• Use Live Presenter and have a student demonstrate how to grab 

and drag the quadratic function to fit the flight path of the ball. 

 
 

TI-Nspire™ Technology Skills:  

• Download a TI-Nspire™ 

document 

• Open a document 

• Move between pages 

• Grab and drag a point 

 

Tech Tips:  

• Make sure the font size on 

your TI-Nspire™ handhelds is 

set to Medium.  

• You can hide the function 

entry line by pressing 

/G. 

 

Lesson Materials: 
Student Activity: 
Modeling_with_a_Quadratic_ 
Function.pdf 
Modeling_with_a_Quadratic_ 
Function.doc 
 
TI-Nspire document  
Modeling_with_a_Quadratic_ 
Function.tns 
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Discussion Points and Possible Answers 
 

 

 

Tech Tip: If students experience difficulty dilating or translating the 

parabola, check to make sure that they have moved the cursor near the 

parabola until the cursor becomes a dilation symbol (õ) or a translation 

symbol (ö). They should then press / x to grab the parabola and use 

the Touchpad to dilate or translate the parabola. 

 

 

Move to page 1.2. 

 

Note: Two tick marks represent one meter. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

1. Graph the parent quadratic function, f(x) = x2, on page 1.2. Transform the parent 

function so that it matches the path of the basketball. What is the equation of the 

quadratic function that matches the path of the basketball? 

 

Note: You may need to drag the function definition away from the graph in order to 

transform the parabola. 

 

Sample answer: Student models will vary slightly. A possible equation is f(x) =  

�0.1(x – 6.65)2 + 8.66. 

 

2.   In this activity, the horizontal distance traveled by the basketball is the independent 

variable. What is the dependent variable? 

 

Answer: The dependent variable represents the vertical height of the basketball. 

 
 

Tech Tip: To determine the maximum height, students can use the Trace 

command by pressing Menu > Trace > Graph Trace and then move the 

cursor to the maximum function value on the parabola. Another method of 

determining the maximum value is by pressing Menu > Analyze Graph > 

Maximum. Students will need to move to the left of the maximum and press 

· or x to set the lower bound. They will then move to the right of the 

maximum and press · or x to set the upper bound. As they move the 

cursor, the coordinates of the maximum will be ghosted. The coordinates of 

the maximum will remain on the screen once the upper bound is set. 
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3. Determine the maximum height of the basketball in meters. Explain your reasoning. 

 

Sample answer: The maximum height of the basketball is 4.33 m. The y-coordinate of 

the vertex is 8.66. Using the scale provided, this value is divided by two to determine 

the height of the ball. 

 

Note: Students can justify their reasoning by using strategies such as reading the value 

from the graph or using the Trace command or the Maximum command. 

 

4. Visualize a point on the ground directly beneath the ball when it reaches its maximum 

height. How far is this point from the person shooting the basketball? Explain your 

reasoning. 

 

Sample answer: The point directly beneath the ball when it reaches its maximum 

height is 3.33 m from the person on the left. The x-coordinate of the vertex is 6.65. 

Using the scale provided, divide this number by 2 to determine the point at which the 

maximum occurs.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                        

 

Note: Students can also justify their reasoning by using other strategies, such as 

reading the value from the graph or using the Trace command or the Maximum 

command. 

 

 

5. How high was the ball when it was a horizontal distance of 2 m from the person 

shooting the basketball? Explain your reasoning. 

 

Sample answer: The ball is 3.98 m high at a horizontal distance of 2 m from the 

person on the left. Use x = 4 since 4 tick marks on the graph represents 2 m. The 

function value at x = 4 is 7.96. Divide this value by 2 because of the scale. 

 

Tech Tip: Students can answer question 5 by evaluating the function for 

an x-value of 4. They can either insert a Calculator page and type f1(4) or 

use the Scratchpad. If they use the Scratchpad, they will need to record 

their equation on a piece of paper and then evaluate the function at x = 4. 

 

6. If the ball followed the path modeled by your quadratic function and the basket was not 

there, how far would it have landed from the person on the left? Explain your 

reasoning. 
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Sample answer: The ball would have landed 8 m from the person on the left if it had 

missed the basket and backboard. The x-intercept to the right of the vertex is (16, 0). 

To determine this, place a point on the function and then drag it toward the x-axis. This 

is the point where the ball hits the ground. Take this value and divide by 2 because of 

the scale. 

 

Note: Students can also justify their reasoning by using other strategies, such as 

reading the value from the graph, using the Trace command or the Zero command 

(Menu > Analyze Graph > Zero), or using the nSolve command in a Calculator page. 

 

Tech Tip: If a student uses the nSolve command, they will get the zero on 

the left, which is the one closest to 0. They will need to specify the 

constraints to solve for the one on the right. The command could be 

nSolve (f1(x) = 0, x, 0, 20). 

 

Extensions: 

1. How far, horizontally, from the person shooting the basketball would the ball be when 

the ball reaches a height of 5 m? 

2. How far is the person standing from the basket? 

3. The equation y = -0.1(x – 8)2 + 9 describes the path of another basketball. The person 

throwing the ball is positioned on the y-axis. How is the path of this ball similar and how 

is it different from the path of the ball in the activity? (Assume the scale is the same.) 
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Activity Overview:  

In this activity, you will use the Content and Documents Workspaces of the TI-Nspire™ Teacher 

Software to transfer files between the computer and the handheld. You will view information about a 

connected handheld, send a document from the computer to the handheld, and preview the contents of a 

document. You will also learn how to transfer files using the Content Explorer in the Documents 

Workspace. 
 

 
 

Materials 

• TI-Nspire™ Teacher Software 

• TI-Nspire™ handheld 

• TI-Nspire™ USB connection cable 
 
 
 
 

Step 1: 

Open the TI-Nspire™ Teacher Software. If the 

Welcome Screen appears when the software is 

opened, go to the Content Workspace by clicking 

View Content. Otherwise, go to the Content 

Workspace by clicking the Content tab. 

 

 

Step 2: 

Connect a TI-Nspire™ handheld to the computer 

using the USB connection cable. In the Resources 

panel, click Connected Handhelds. 

 

Note: Multiple handhelds can be connected to 

the computer using multiple USB ports, 

USB hubs, or the TI-Nspire™ Docking 

Station. If multiple handhelds are 

connected to the computer, then multiple 

handhelds appear in the list of 

Connected Handhelds. 
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Step 3: 

The connected handheld appears in the Content Window, along with battery, storage, and OS 

information. More detailed information appears in the Handheld Information window. 

 

Step 4: 

Locate a TI-Nspire™ document on your computer by going to the Resources panel and accessing Local 

Content. To locate a file on the desktop, click Desktop. To locate a file in the My Documents folder, 

click Documents. Send the TI-Nspire™ document to the connected handheld by clicking the file and 

selecting   Send to Connected Handhelds. 

 

Note:       The TI-Nspire document can also be sent to the connected handheld by right-clicking the file 

and selecting Send to Connected Handhelds. 
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Step 5: 

Upon selecting Send to Connected Handhelds, the Transfer Tool window appears, the Setup tab is 

active, and the current TI-Nspire™ document is listed. To add an additional file to the transfer list, select 

Add to Transfer List and locate the additional file. To remove a file from the transfer list, select the file 

and click Remove Selected. 

 

The Destination Folder is the folder on the handheld where the file will be placed. To change the 

Destination Folder, select the file and go to the Edit Destination Folder field. To select an existing 

folder, select it from the drop-down menu and click Change. To create a new folder, type its name into 

the field and click Change. To send the file to the handheld, click Start Transfer. Once the Status tab 

indicates that the transfer is complete, click Stop Transfer 

 
 
 
 
 
 
 
 
 
 
 
 
 

Step 6: 

To view the files and folders on a connected handheld, right-click the handheld and select Open. From 

the right-click menu, the selected handheld can be renamed, its current screen can be captured, the OS 

can be checked, and an updated OS can be installed.  
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Step 7: 

The files and folders on a connected handheld can also be viewed by going to the Resources panel and 

selecting from the list of Connected Handhelds. When a TI-Nspire™ document is selected, an icon 

appears labeled Click here to preview document. Click the icon to preview the first page of the  

TI-Nspire™ document. Double-click the file to open it in the Documents Workspace. 

 

 

Step 8: 

Files can also be transferred between the computer 

and connected handhelds using the Content Explorer 

in the Documents Workspace. 

 

To transfer a TI-Nspire™ document from the computer 

to the connected handheld, locate the file in the 

Computer panel. Click, drag, and drop it into the 

desired handheld or folder in the Connected 

Handhelds panel. 

 

To transfer a TI-Nspire™ document from the 

connected handheld to the computer, locate the file in 

the Connected Handhelds panel. Click, drag, and 

drop it into the desired folder in the Computer panel. 
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Activity Overview:  

In this activity, you will explore basic features of the TI-Nspire™ Teacher Software. You will explore the 

Welcome Screen, add pages with Calculator and Graphs applications, and explore the menus and 

submenus of each application. You will explore the five tabs within the Documents Toolbox, as well as 

the options available in the Documents toolbar and the Status bar. 
 
 
 

Materials 

• TI-Nspire™ Teacher Software 
 
 
 
 

Step 1: 

Open the TI-Nspire™ Teacher Software. The Welcome Screen displays an icon for each of the seven 

applications: Calculator, Graphs, Geometry, Lists & Spreadsheet, Data & Statistics, Notes, Vernier 

DataQuest™, and Question. To see a brief description of each application, hover the cursor over each 

icon. 

The Welcome Screen also allows you to view content, manage handhelds, transfer documents, and 

open documents. To see a brief description of each option, hover the cursor over each icon on the right. 

To view the Welcome Screen at any time, go to Help > Welcome Screen 

To create a new document with a Calculator application as the first page, click . 
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Step 2: 

The Calculator application allows you to enter and evaluate 

mathematical expressions as well as create functions and 

programs. 

 

In most cases, each application has a unique menu of 

commands and tools. To view the Calculator menu, go to 

the Documents Toolbox and select the  Document 

Tools tab. 

 

Each item in the Calculator menu has a submenu. Explore 

the various menus and submenus by entering and 

evaluating your own expressions. 

 

Note: To access the Calculator menu on the handheld, 
press b. 

Step 3: 

The  Utilities tab contains Math Templates, Symbols, 

Catalog, Math Operators, and Libraries panes. Only one 

pane is displayed at a time, and the Math Templates pane 

is the default pane. Explore each of the other panes by 

clicking them. 

 

To insert a Math Template into the Calculator application, 

double-click it. Explore various Math Templates by 

evaluating your own expressions involving fractions, 

exponents, square roots, logarithms, and absolute value 

expressions. 

 

Note: When evaluating expressions, the Calculator 

application displays rational expressions by 

default. To display a decimal approximation when 

evaluating an expression, press CTRL + Enter. 
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Step 4: 

The  Insert menu allows you to insert problems 

and pages, along with each of the eight applications. 

A problem can contain multiple pages, and variables 

that are linked within a problem are linked across 

pages.  

 

Insert a Graphs application by selecting  Insert > 

 Graphs.   

 

The Graphs application allows you to graph and 

analyze relations and functions. Explore the various 

menus and submenus available in the Graphs 

application. 

 

Step 5: 

Graph the function f(x) = x by typing x into the function 

entry line and pressing Enter. 

 

Rotate the line by hovering the cursor over the upper-right 
corner of the graph. When the rotational cursor é 

appears, rotate the line by clicking and dragging it. 

 

 

 

 

Translate the line by hovering the cursor over the line near 
the origin. When the translational ö cursor appears, 

translate the line up and down by clicking and dragging it. 
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Step 6: 

Since you have inserted a Calculator application and a 

Graphs application, your TI-Nspire™ document now has 

two pages. The Page Sorter view allows you to view 

thumbnail images of all pages in the current TI-Nspire™ 

document. 

 

Access the Page Sorter by going to the Documents 

Toolbox and clicking the  Page Sorter tab. Pages can 

be rearranged by grabbing and moving them. Right-clicking 

allows for pages to be cut, copied, and pasted. 

 

Note: To access Page Sorter in the handheld, press 
/£. To right-click in the handheld, press 

/b. 

Step 7: 

The Documents toolbar allows you to create, open, and save a TI-Nspire™ document. Commands such 

as Undo, Redo, Cut, Copy, and Paste are also available. Explore these options by hovering the cursor 

over each icon. Pages, problems, and applications can be inserted and variables can be stored.  

 

Take a Screen Capture of the current page by selecting  Take Screen Capture >  Capture Page. 

This Screen Capture can be saved as an image. Page layouts allow multiple applications to appear on 

one screen. Explore the various page layouts that are available by clicking  Page Layout. Fill color, 

line color, and text color can also be changed. 
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Step 8: 

The Status Bar allows the user to access settings, change the Document View from Handheld mode to 

Computer mode, and adjust the scale of the screen. Change the Document View to Computer mode by 

clicking  Computer mode. Change the Document View back to Computer mode by clicking  

Handheld mode. 

 

  

 

Step 9: 

To access the TI-SmartView emulator, go to the 

Documents Toolbox and select the  TI-SmartView 

tab.  

 

TI-SmartView has three available views: Handheld 

only, Keypad + SideScreen, and Handheld + Side 

Screen. Explore each of these views. 

 

TI-SmartView has three available keypads: TI-Nspire 

CX™, TI-Nspire™ with Touchpad, and TI-Nspire™ 

with Clickpad. Each keypad has three available views: 

Normal, High Contrast, and Outline. Click the  

Keypad menu and explore each keypad and view. 
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Step 10: 

View the Document Settings by going to 

File > Document Settings. The 

Document Settings can also be viewed 

by going to the Status Bar and clicking 

Settings.  

 

General settings apply to the entire  

TI-Nspire™ document, while Graphs & 

Geometry settings apply only to the 

Graphs and Geometry applications. 

 

Note: To move across fields in the Document Settings window, press e. To change the setting in 

a given field, press ¤, select the desired setting, and press ·. To exit the window, press e 

until OK is highlighted and press ·. 

Step 11: 

The Content Explorer allows you to access local content 

on your computer and manage content on connected 

handhelds. Explore the Content Explorer by clicking the 

 Content Explorer tab. 
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Activity Overview:  

In this activity, you will learn how to insert images into Graphs, Geometry, and Question applications. You 

will also learn how to move, resize, compress, and stretch an image, as well as make it appear more 

transparent.  
 
 

Materials 

• TI-Nspire™ Teacher Software 
 
 
 

Step 1:     Open the TI-Nspire™ Teacher Software. If the Welcome Screen appears when the software 

is opened, click  to create a new document with a Graphs application as its first page. 

Otherwise, insert a Graphs application by clicking  Insert >  Graphs. 

Note: Images can be inserted into Graphs, Geometry, Data & Statistics, Notes, and Question 

applications.  

Step 2:    Insert an image into the Graphs application by 

clicking  Insert >  Image. A selection of 

images is preloaded in the My Documents >  

TI-Nspire > Images folder. Select Ferris Wheel. 

jpg and click Open. 

Note: Although the TI-Nspire™ Teacher Software comes 

with a selection of preloaded images, all .jpg, .jpeg, 

.bmp, and .png images are supported. The optimal 

format for images is .jpeg 560×240. Images 

substantially larger than this may take the document 

longer to load on the handheld. Images appear in 

grayscale for TI-Nspire™ Touchpad and Clickpad 

handhelds updated to the latest operating system.  

Step 3: Images can be moved, resized, and vertically or 

horizontally stretched or compressed. To select an 

image in the Graphs, Geometry, or Question 

application, right-click the image and choose Select 

> Image. To select an image in the Notes 

application, click the image. To move the image, 

grab and move its interior. To resize the image, grab 

and move a corner. To vertically stretch or compress 

the image, grab and move the top or bottom edge. 

To horizontally stretch or compress the image, grab 

and move the left or right edge. 

 

Note: To right-click on a handheld, press /b. To grab an object, press /x. To let go of an 

object, press d. 
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Step 4: To make an image appear more transparent, insert 

it in a Geometry application and then change the 

page to a Graphs application.  

 Insert a Geometry application by clicking  Insert 

>  Geometry. Then insert an image by selecting 

 Insert >  Image. Again, choose  

Ferris Wheel.jpg. Change the Geometry 

application to a Graphs application by selecting 

View > Graphing. 

 

Step 5:     Insert a Question application by clicking Insert >  Question. The Choose Question 

Type window appears. There are four general question types: Multiple Choice, Open 

Response, Equations, and Coordinate Points & Lists. Images can be inserted into each 

question type. Select Equation > y =. 

Step 6: To change the question properties in the  

Document Tools pane, go to the Configuration 

panel. In the Equation Properties panel, select 

Include a Graph Preview and change the Prompt 

Location to Top. 

Note: To maximize the area of the Graph Preview, grab 

and move the gray bar separating the question and 

answer fields from the Graph Preview. 

 

Step 7: Insert an image into the Graph Preview by clicking 

the graph and selecting  Insert >  Image. 

Choose Bridge1.jpg and click Open. Type the 

following into the question field: 

Write an equation to model the suspension cables. 
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Activity Overview: 
This activity describes how to construct a slider for a quadratic function, change the Slider Settings, and 
use the slider to change the parameter in the function f(x) = a · x2.  
 
 
 
 

Step 1: 

Press c and select New Document to start a new document.  

 

Step 2: 

Select Add Graphs. 

 

 

Step 3: 

The cursor is in the function entry line at the bottom of the screen. To 

the right of the equals sign, enter a · x2 by pressing A r X q. 

Press ·.  

Note: The function f1(x) = a · x2 has not been graphed since the 

value of the parameter “a” has not been defined. 

 

 

Step 4: 

Insert a slider by pressing Menu > Actions > Insert Slider. 

 

 

 

 

Note: The slider has a closed “hand” attached so it can be moved to 

another location on the screen. Move the slider to the desired 

location and press x or · to place the slider. 
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Step 5: 

The current slider variable, v1, is highlighted. Type over this variable 

by pressing the letter A (the parameter in f1(x)). 

 

 

 

Step 6: 

Press ·. The parabola should now be visible in the graphing 

window. 

 

 

 

Step 7: 

To change the settings for the slider, use the Touchpad to move the 

pointer over the slider. Press / b to display the Context menu. 

Select the Settings option. 

  

 

Step 8: 

Press e to move to the each field, and type in the desired setting 

values. Change the settings to match the screen at the right. Press 

· to close the Slider Settings dialog box and save the new 

settings. 

  

Step 9:  

To move the slider, use the Touchpad to move the cursor over the 

slider controller. The Grab tool, ÷, will appear. Press /x to 

close the “hand” and grab the slider controller, Drag the slider 

controller to change the value of the slider. Observe the effects on the 

graph of the parabola. 

What math concepts can be explored with this activity? 

What questions can we ask to highlight the math? 

 

\ 
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Open the TI-Nspire™ document Understanding_Slope. 

 

The slope of a line can be determined using two points on the line. 

Does it matter which two points you choose? This activity introduces the 

idea of slope with movable points on a line. 

 

 

Move to page 1.2. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

1. Following the arrows from point A to point B, what is the value of the vertical change?  

Of the horizontal change? 

 

 

2. Move one or both points until the values for both the vertical and horizontal changes 

are positive. Describe the line. 

 

 

3. Write your answer to question 2 in the first row of the table below. Move your points to 

match each pair of remaining conditions. For each case, describe what the line looks like. 
 

Vertical Change Horizontal Change Does the line rise or fall from left to right? 

Positive Positive  

Positive Negative  

Negative Positive  

Negative Negative  

 

4. What patterns do you observe in your descriptions in the previous table? 

 

 

5. Set point A to (–4, 1). 

a. Where must you place point B for the line to rise from left to right? 

  

b. Where must you place point B for the line to fall from left to right? 
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6. Set point A to coordinates of your choice. 

a. Where must you place point B for the line to rise from left to right? 

 

 

b. Where must you place point B for the line to fall from left to right? 

 

 

7. Ann says that her point B is above and to the right of point A. Elizabeth says that her 

point B is below and to the left of point A. Jessica says her point B is to the right of 

point A. Whose line must rise from left to right? Explain. 

 

 

 

8. The slope of a line is defined as the ratio of the vertical change to the horizontal change 

for any two distinct points on the line. 

a. What relationships must exist between the vertical and horizontal changes to 

produce a positive slope? 

 

 

b. To produce a negative slope? 

 

 

 

9. In each question so far, you have been following the arrows from point A to point B. If 

you started at point B and moved to point A, how would that change your previous 

answers? 
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Math Objectives 

 Students will identify positive and negative slope. 

 Students will know that the sign of the ratio of the vertical and 

horizontal changes determines the sign of the slope. 

 Students will recognize that a positive slope indicates a line is 

rising from left to right and a negative slope indicates a line is 

falling from left to right. 

 Students will reason abstractly and quantitatively (CCSS 

Mathematical Practice). 

 Students will construct viable arguments and critique the 

reasoning of others (CCSS Mathematical Practice). 

Vocabulary 

 slope 

 vertical change 

 horizontal change 

About the Lesson 

 This lesson is designed to help students see the connections 

between the sign of the ratio of the vertical and horizontal change 

as they relate to the sign of the slope of a line. 

 As a result, students will: 

 Move points in the coordinate plane 

 Observe how a line moves 

 Observe the relationships between the signs of the vertical 

and horizontal change 

 

TI-Nspire™ Navigator™ System 

 Use Quick Poll to assess students’ understanding. 

 Use Screen Capture to compare students’ lines. 

 Collect student documents and analyze the results. 

 Use the Review and Portfolio workspaces to display students’ 

answers. 

 

 

 
 

TI-Nspire™ Technology Skills:  

 Download a TI-Nspire™ 

document 

 Open a document 

 Move between pages 

 Grab and drag a point on a 

line 
 

Tech Tips:  

 Make sure the font size on 

your TI-Nspire™ handheld is 

set to Medium. 

 You can hide the function 

entry line by pressing  

/ G. 

 

Lesson Files: 

Student Activity 

Understanding_Slope_ 
Student.doc 

TI-Nspire document  

Understanding_Slope.tns  

 

Visit www.mathnspired.com for 

lesson updates and tech tip 

videos. 
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Discussion Points and Possible Answers 

 

 

 

Tech Tip: If students experience difficulty dragging the point, check to 

make sure that they have moved the arrow until it becomes a hand (÷) 

getting ready to grab the point. Then press / x to grab the point and 

close the hand ({). 

 

 

Move to page 1.2. 

 

1. Following the arrows from point A to point B, what is the 

value of the vertical change? Of the horizontal change? 

 

Answer: The vertical change is the number of units counted 

up/down on the triangle (height of the slope triangle). The 

horizontal change is the number of units counted left/right on the 

triangle (length of the slope triangle). 

 

 

Teacher Tip: The main point here is to focus on the amount of the vertical 

and horizontal changes. Students can determine this by simply counting 

the number of units. Some students might say something about subtracting 

the coordinates. If so, this would be a good opportunity to discuss the slope 

formula. If students want to talk only about looking at the fraction at the top 

of the graph screen, emphasize counting to determine each change. 

 

2. Move one or both points until the values for both the vertical and horizontal changes 

are positive. Describe the line. 

 

Answer: The graph rises (goes up) from left to right. 

 

TI-Nspire™ Navigator™ Opportunity: Quick Poll and/or Screen Capture 

See Note 1 at the end of this lesson. 

 

Teacher Tip: The main point of this question is to identify the 

characteristics of a positive slope. If any students want to talk about 

steepness, encourage the discussion, and then focus on the idea that no 

matter how steep the line is, it will rise from left to right. 
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Tech Tip: It is possible to move point A or point B outside of the grid of the 

coordinate plane. If this happens, simply move the point(s) back to the 

coordinate plane. 

 

3. Write your answer to question 2 in the first row of the table below. Move your points to 

match each pair of remaining conditions. For each case, describe what the line looks like. 

 

Answer: The completed table is below. 
 

Vertical Change Horizontal Change Does the line rise or fall from left to right? 

Positive Positive Rise 

Positive Negative Fall 

Negative Positive Fall 

Negative Negative Rise 

4. What patterns do you observe in your descriptions in the previous table? 

 

Answer: When the ratio is positive (same signs), the line rises from left to right. When 

the ratio is negative (opposite signs), the line falls from left to right. 

Teacher Tip: Students might observe patterns in steepness. Direct discussion 

toward identifying whether the line is rising or falling from left to right. 

 

5. Set point A to (–4, 1). 

a. Where must you place point B for the line to rise from left to right? 

 

Answer: Point B must be above and to the right of point A or below and to the left 

of point A. 

 

b. Where must you place point B for the line to fall from left to right? 

 

Answer: Point B must be below and to the right of point A or above and to the left 

of point A. 

Teacher Tip: You might also ask students to write inequalities for the 

conditions of the coordinates. For example, in the first question, in order for 

the line to rise, x > –4 and y > 1 (or x < –4 and y < 1) must be true for point 

B. Similarly, in order for the line to fall, x > –4 and y < 1 (or x < –4 and y > 

1) must be true for point B. 
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6. Set point A to coordinates of your choice. 

a. Where must you place point B for the line to rise from left to right? 

 

Answer: Point B must be above and to the right of point A or below and to the left 

of point A. 

 

b. Where must you place point B for the line to fall from left to right? 

 

Answer: Point B must be below and to the right of point A or above and to the left 

of point A. 

 

7. Ann says that her point B is above and to the right of point A. Elizabeth says that her 

point B is below and to the left of point A. Jessica says her point B is to the right of point 

A. Whose line must rise from left to right? Explain. 

 

Answer: Both Ann’s and Elizabeth’s lines rise from left to right. Jessica’s line will 

sometimes rise from left to right, but not always (depending on whether point B is 

above point A). 

 

Teacher Tip: Although students might think point B being to the right of 

point A is sufficient to ensure a positive slope, it is important for them to 

understand it is not. 

 

8. The slope of a line is defined as the ratio of the vertical change to the horizontal change 

for any two distinct points on the line. 

a. What relationships must exist between the vertical and horizontal changes to 

produce a positive slope? 

 

Answer: Same signs produce a positive slope (rising from left to right). 

 

b. To produce a negative slope? 

 

Answer: Different signs produce a negative slope (falling from left to right). 

Teacher Tip: This is the main point of the lesson. Guide the discussion 

toward the ratio of the signs of horizontal and vertical change. Some 

students might still have trouble remembering the rules for division with two 

signed numbers. Remind them that when the signs are the same, the 

quotient is positive, and when they are opposite, the quotient is negative. 
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9.   In each question so far, you have been following the arrows from point A to point B. If 

you started at point B and moved to point A, how would that change your previous 

answers? 

 

Answer: Each sign for the horizontal and vertical change would be the opposite, but 

the ratio of signs would still be the same (meaning the slope would still be the same 

whether you move from point A to point B or from point B to point A). 

 

Teacher Tip: Have students explain this in their own words. This is an 

important point for the students to realize, and many might not immediately 

make the connection. 

 

Extension 

10. What relationships exist between the coordinates of points A and B and the slope of the 

line passing through them? 

 

Answer: The coordinates can be used to determine the signs of the vertical and 

horizontal changes, and the ratio of the signs determines whether the slope will be 

positive or negative. 

 

Teacher Tip: This question is designed to look ahead at the formula for 

slope. Not all students will be able to see how the values for change were 

calculated using the coordinates (for example, change in y over change in x). 

 

TI-Nspire™ Navigator Opportunity: Quick Poll 

See Note 2 at the end of this lesson. 

 

 

Wrap Up 

Upon completion of the discussion, the teacher should ensure that students understand: 

 That the ratio of the signs of the vertical and horizontal changes determines the sign of 

slope of a line 

 How to use the ratio of the vertical change to the horizontal change to determine 

whether the slope of a line is positive or negative 

 That a positive slope indicates that a line rises from left to right and a negative slope 

indicates that a line falls from left to right 
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TI-Nspire™ Navigator 

Note 1 

Question 2, Quick Poll and/or Screen Capture: You may want to take Screen Captures 

of student work to show the different possible lines with positive slopes. 

 

Note 2 

Questions 8, 9, and 10, Quick Poll: You may want to send a Quick Poll to determine 

whether students have reached the proper conclusions about lines with positive and 

negative slopes. 
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Open the TI-Nspire document 

Linear_Inequalities_in_Two_Variables.tns. 

 

The solution set for an inequality in two variables is the set of 

ordered pairs that satisfy that inequality. This activity gives you 

a visual way of thinking about the solution set to an inequality in 

two variables. 

  

 

Move to page 1.2. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

1. Move point P. Describe the changes that occur as you move the point. What stays the same? 

 

 

2. Why do you think the line y = x + 1 is called a boundary line? 

 

 

3. Complete the table below by moving the point to three locations: above the boundary line, on the 

boundary line, and below the boundary line. 
 

 
Above the  

Boundary Line 
On the  

Boundary Line 
Below the 

Boundary Line 

Coordinates (x, y) of 
the Point 

   

Equation or Inequality 
on Screen 

   

Verify by substituting 
the coordinates into the 
equation or inequality. 

   

 

Move to page 2.1. 

 

4. The word true or false appears depending on where the point is located. What does true or false 

refer to in this context? 

 

 

5. a. Select < for the inequality symbol by clicking on the up or down symbol on the screen ( or ) 

so that the inequality reads y < –x + 1. Now move the point to a location where this inequality is 

true. Verify that the coordinates of the point you chose make the inequality a true statement. We 

say that such a point satisfies the inequality. 

 

 

52



  
Linear Inequalities in Two Variables 
Student Activity 

 

©2011 Texas Instruments Incorporated 2 education.ti.com 

b. Explain why every point directly below this point must also satisfy the same inequality. 

 

 

c. Explain why every point directly to the left of this point must also satisfy the same inequality. 

 

 

6. a. Select > for the inequality symbol by clicking on the up or down symbol on the screen ( or ) 

so that the inequality reads y > –x + 1. Now move the point to a location where this inequality is 

true. Verify that the coordinates of the point you chose satisfy the inequality.  

 

 

b. Explain why every point directly above this point must also satisfy the same inequality. 

 

 

c. Explain why every point directly to the right of this point must also satisfy the same inequality. 

 

 

7. The solution set for an inequality in two variables (x, y) is the set of all points in the plane that satisfy 

that inequality. 

a. Click the  or  on the screen to change the inequality symbol to < and then to >. What points 

satisfy these new inequalities that did not satisfy the inequalities in Questions 5 or 6? 

 

 

b. Explain in your own words how to graph the solution set to an inequality.  
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Math Objectives 

 Students will discover the basics of graphing a linear inequality, e.g., 

the differences among the graphs of y > ax + b, y > ax + b,  

y < ax + b, and y < ax + b. 

 Students will use a test point to check if the correct half plane is 

shaded. 

 Students will sketch the graphs of linear inequalities and select a 

test point to verify the solution set. 

 Students will use appropriate tools strategically (CCSS 
Mathematical Practice). 

Vocabulary 

 linear inequality 

 half plane 

About the Lesson 

 This lesson involves the basics of graphing linear inequalities. 

 As a result, students will: 

 Move a point that is part of the solution set to an inequality in 

the coordinate plane and observe how the algebraic 

representation changes based on the location of the point. 

 Select an inequality symbol to see when the boundary line is 

included in the graph of the inequality and move a point to see 

if it is part of the solution. 

 Formulate the basic concepts of graphing inequalities. 

 Graph systems of inequalities. 

Related Lessons  

 Prior to this lesson: Linear Inequalities in One and Two Variables: 

Rays and Half Planes 

 After this lesson: Exploring Graphs of Inequalities 

 

TI-Nspire™ Navigator™ System 

 Use Screen Capture to see if students understand how to use the 

TI-Nspire file. 

 Use Screen Capture and Quick Polls to determine if students 

understand that the zeros of a quadratic function are the same as 

the zeros of its linear factors.  

 

TI-Nspire™ Technology Skills:  

 Download a TI-Nspire 

document 

 Open a document 

 Move between pages 

 Grab and drag a point 
 

Tech Tips:  

 Make sure the font size on 

your TI-Nspire handheld is set 

to Medium.  

 You can hide the function entry 

line in a Graphs & Geometry 

page by pressing / G. 

 

Lesson Materials: 

Student Activity 

 Linear_Inequalities_in_Two_ 

Variables_Student.pdf 

 Linear_Inequalities_in_Two_ 

Variables_Student.doc 

TI-Nspire document  

 Linear_Inequalities_in_Two_ 

Variables.tns 

 

Visit www.mathnspired.com for 

lesson updates and tech tip 

videos. 
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Discussion Points and Possible Answers 

 

 

 

Tech Tip: If students experience difficulty dragging a point, check to make 

sure that they have moved the arrow close to the point. The arrow should 

become a hand (÷) getting ready to grab the point. Be sure that the word 

point appears. Press / x to grab the point and the hand will close. 

Drag the point. After the point has been moved, press d to release the 

point. 

 

Teacher Tip: Make sure that students begin at the point (2, 3) on the line. 

 

 

Move to page 1.2. 

 

1. Move point P. Describe the changes that occur as you move the 

point. What stays the same? 

 

Answer: The coordinates of the point change, the equality sign 

changes back and forth to an inequality sign, and the shading   

changes as the point moves from one side of the boundary line to the other. The slope of the 

boundary line remains the same. The y remains on the left, and x + 1 remains on the right. 

 

 

Teacher Tip: Be sure students start on the point (2, 3). Because they are 

familiar with graphing lines, students will be able to start on familiar ground 

(a line) and make the transition from graphing equalities to graphing 

inequalities. Give students enough time to explore. Encourage them to 

provide more than one answer to the question. 

 

2. Why do you think the line y = x + 1 is called a boundary line? 

 

Answer: The line y = x + 1 is called a boundary line because it is the boundary or “edge” of the 

solution of the inequality. 

 

Teacher Tip: This might be a good opportunity to go over some of the 

vocabulary that students will need for this topic. Other questions that you 

might ask: Can the x-value ever be greater than the y-value? What is the 

maximum value that x can have when y = 3? 
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3. Complete the table below by moving the point to three locations: above the boundary line, on the 

boundary line, and below the boundary line. 

 

Answer: Completed table is below. 

 
 

 Above the  

Boundary line 

On the  

Boundary line 

Below the 

Boundary line 

Coordinates (x, y) of 

the Point 
Example: (1, 4) Example: (–3, –2) Example: (1, –5) 

Equation or 

Inequality on Screen 
y > x + 1 y = x + 1 y < x + 1 

Verify by substituting 

the coordinates into 

the equation or 

inequality. 

4 > 1 + 1 

4 > 2 (check) 

–2 = –3 + 1 

–2 = –2 (check) 

–5 < 1 + 1 

–5 < 2 (check) 

 

Teacher Tip: Have students share their answers with the class. You may 

want to project the calculator screen on the board, and have students come 

up to plot their points. Students should start to discover that there are an 

infinite number of points that satisfy the equation/inequalities, and that the 

shaded region contains all solutions to the inequality. 

 

TI-Nspire Navigator Opportunity: Live Presenter 

See Note 1 at the end of this lesson. 

Move to page 2.1. 

 

4. The word true or false appears depending on where the point is 

located. What does true or false refer to in this context? 

 

Answer: True or false refers to whether or not the x- and y-values 

at that location satisfy the equation or inequality.  

 

 

Teacher Tip: Make sure that all students start with the equality sign and 

select the point (–2, 3), which lies on the line. 

 

By starting with the point (–2, 3), which is on the line, students start with a 

true statement. From here, they can better understand why moving the point 

off the line produces a false statement. This part of the activity as well as the 
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next one introduces students to the concept of utilizing a test point to 

determine the solution of a linear inequality. 

 

5. a. Select < for the inequality symbol by clicking on the up or down symbol on the screen ( or) so 

that the inequality reads y < –x + 1. Now move the point to a location where this inequality is true. 

Verify that the coordinates of the point you chose make the inequality a true statement. We say 

that such a point satisfies the inequality. 

 

Answer: Many answers are possible as long as the chosen point’s coordinates satisfy the 

inequality. 

 

b. Explain why every point directly below this point must also satisfy the same inequality. 

 

Answer: Each point directly below this point will have exactly the same x-coordinate, so the right-

hand side of the inequality won’t change value. The y-coordinate will be LESS than the original y-

coordinate; so the left-hand side of the inequality will be smaller; and the inequality will still hold. 

 

c. Explain why every point directly to the left of this point must also satisfy the same inequality. 

 

Answer: Each point directly to the left of this point will have exactly the same y-coordinate, so the 

left-hand side of the inequality won’t change value. The x-coordinate will be LESS than the original 

x-coordinate; so –x will be larger and the right-hand side of the inequality will be even larger; and 

the inequality will still hold. 

 

TI-Nspire Navigator Opportunity: Live Presenter 

See Note 2 at the end of this lesson. 

6. a. Select > for the inequality symbol by clicking on the up or down symbol on the screen ( or) so 

that the inequality reads y > –x + 1. Now move the point to a location where this inequality is true. 

Verify that the coordinates of the point you chose satisfy the inequality.  

 

Answer: Many answers are possible, as long as the chosen point’s coordinates satisfy the 

inequality. 

 

b. Explain why every point directly above this point must also satisfy the same inequality. 

 

Answer: Each point directly above this point will have exactly the same x-coordinate, so the right-

hand side of the inequality won’t change value. The y-coordinate will be GREATER than the 

original y-coordinate, so the left-hand side of the inequality will be LARGER than the original. The 

inequality will still hold. 
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c. Explain why every point directly to the right of this point must also satisfy the same inequality. 

 

Answer: Each point directly to the right of this point will have exactly the same y-coordinate, so 

the left-hand side of the inequality won’t change value. The x-coordinate will be GREATER than 

the original x-coordinate, so –x will be SMALLER and the right-hand side of the inequality will be 

SMALLER than the original. The inequality will still hold. 

 

Teacher Tip: Here’s another opportunity for students to share their 

reasoning. Not only is the student’s test point a solution to the inequality, but 

also all of the other solutions lie in the same half-plane. 

 

7. The solution set for an inequality in two variables (x, y) is the set of all points in the plane that satisfy 

that inequality. 

a. Click the  or  on the screen to change the inequality symbol to < and then to >. What points 

satisfy these new inequalities that did not satisfy the inequalities in Questions 5 or 6? 

 

Answer: The points on the line itself now satisfy these inequalities. 

 

b. Explain in your own words how to graph the solution set to an inequality.  

 

Answer: First, find the line represented by replacing the inequality symbol with an equality 

symbol. Then find which side of the line satisfies the inequality by testing with a point. Shade that 

side. Use a dotted line for strict inequalities and a solid line for inclusive inequalities. 

 

TI-Nspire Navigator Opportunity: Quick Poll 

See Note 3 at the end of this lesson. 

 

 

  

Wrap Up 

Upon completion of the discussion, the teacher should ensure that students understand: 

 The purpose of the boundary line 

 When to include it in the graph of the inequality 

 When it is solid and when it is dotted 

 The shading of the appropriate half-plane 

 How to determine which side of the boundary line to shade 

 When to shade below the boundary line 
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TI-Nspire Navigator 

Note 1 

Question 3, Live Presenter: Select a student to be the Live Presenter and illustrate the answers to 

Question 3. Have the presenter show that there is more than one correct answer for each cell in the table. 

 

Note 2 

Question 5, Live Presenter: Have a student be the Live Presenter to illustrate how to move up and 

down through the equality and inequality signs. 

 

Note 3 

Question 7, Quick Poll: Use the True False response and verbally ask students to respond either True 

or False to the following statements. You may want to write the inequalities on the board, too. 

1. In the graph of y < 2x + 3, the boundary line will be a solid line. (Answer: False) 

2. In the graph of y > 3x – 2, the boundary line will be a dotted or dashed line. (Answer: False) 

3. In the graph of y > x + 1, the point (0, 1) is in the graph of the solution. (Answer: False. The point  

(0, 1) is on the boundary line, which is a dotted or dashed line.) 

4. Create your own True/False questions as needed. 
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Open the TI-Nspire document 

Transformations_of_Functions_1.tns. 

 

This activity investigates some transformations of functions. The 

graph of a function y = f(x) will be translated. You will be able to 

compare the new graph with the original to determine the impact of 

changes to the function on the graph. 

 

 

Move to page 1.2. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

Part One: y = f(x) + k. 

1. Drag the point to change the value of k. 
a. What happens to the graph of  ( )y f x k2  as the value of k changes? 

 
b. Move the point so that k > 0. Where is the graph of  ( )y f x k2  compared to 1 ( )y f x ? 

 
c. Move the point so that k < 0. Where is the graph of  ( )y f x k2  compared to 1 ( )y f x ? 

 
d. Move the point so that k = 0. Where is the graph of  ( )y f x k2  compared to 1 ( )y f x ? 

 

 

2. For each of the following statements, indicate if it is True or False, and explain why you 

think so. 
a. When k is negative, the graph of  ( )y f x k2  is below the graph of 1 ( )y f x .  

 
b. When k is positive, the graph of  ( )y f x k2  is below the graph of 1 ( )y f x . 

 
c. There is a value of k that will make part of the graph of  ( )y f x k2  above the 

graph 1 ( )y f x  and the rest below the graph of 1 ( )y f x . 
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3. The graph of  ( )y f x k2 , when k  0, is a vertical shift of the graph of 1 ( )y f x . Why 

does the graph shift vertically? 

 

 

 

Move to page 2.1. 

 

Part Two: y = f(x – h) 

 

4. Drag the point to change the value of h.  
a. What happens to the graph of 2 ( )y f x h  as the value of h changes?  

 
b. Move the point so that h > 0. Where is the graph of 2 ( )y f x h   compared to 1y x ? 

 
c. Move the point so that h < 0. Where is the graph of 2 ( )y f x h   compared to 1 ( )y f x ? 

 
d. Move the point so that h = 0. Where is the graph of 2 ( )y f x h   compared to 1 ( )y f x ? 

 

 
5. The graph of 2 ( )y f x h  , when h  0, is a horizontal shift of the graph of 1 ( )y f x . Why does the 

graph shift horizontally? 

 

 

6.   All of the functions on pages 1.2 through 3.1 were of the absolute value type.  In other words, 
1y x and   2y x h k .  How does the graph of   2 2 1y x  compare to the graph of 

1y x ? Use page 3.1 of the tns document on your handheld to help determine the 

transformations. 

 

 

 

7.   The vertex of the absolute value graph function is where the graph turns back up or goes back 
down.  What is the vertex of   2 2 1y x ? Check with page 3.1.   

 
8.  What is the vertex of   2 3 4y x ?  What is the vertex of   2y x h k  ? 
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9. Pages 4.1 and 5.1 use a different type of function. For each transformation in a, b and 
c, describe the changes in the graph of 1 ( )y f x  shown. Then sketch the graph of y2. 

Use pages 4.1 and 5.1 to check answers. 

 
a. 2 ( 1)y f x   b. 2 ( ) 2y f x   c. 2 ( 1) 2y f x    
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Math Objectives 
 Students will recognize the effect of a horizontal and vertical 

translation on the graph of a function. 

 Students will relate the transformation of a graph y = f(x) by a 

horizontal and vertical translation to the symbolic representation 

of the transformation: that is y = f(x) + k shifts the graph up or 

down and y = f(x – h) shifts the graph right or left. 

 Students will combine translations to describe the graph of the 

function y = f(x – h) + k in terms of y = f(x). 

 Students will look for and make use of structure (CCSS 

Mathematical Practice). 

 Students will use appropriate tools strategically (CCSS 

Mathematical Practice).  

 

Vocabulary 

 vertical translation 

 horizontal translation 

 vertex of an absolute value function 

 

About the Lesson 
 This lesson involves investigating vertical and horizontal 

translations of a function. 

 As a result, students will: 

 Recognize how transformations of the form y = f(x) + k and  

y = f(x – h) change the graph of y = f(x). 

 

TI-Nspire™ Navigator™ System 

 Use Quick Polls to check student understanding. 

 Use Screen Capture to examine patterns that emerge. 

 Use Live Presenter to engage and focus students. 

 Use Teacher Edition computer software to review student 

documents. 

 

 
 

TI-Nspire™ Technology Skills: 

 Download a TI-Nspire 

document 

 Open a document 

 Move between pages 

 

 

Tech Tips:  

 Make sure the font size on 

your TI-Nspire handheld is 

set to Medium.  

 You can hide the function 

entry line by pressing 

/G. 

 

Lesson Materials: 
Student Activity 
Transformations_of_Functions_
1_Student.pdf 
Transformations_of_Functions_
1_Student.doc 

TI-Nspire document  
Transformations_of_Functions_
1.tns 

 

Visit www.mathnspired.com for 

lesson updates and tech tip 

videos. 
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Discussion Points and Possible Answers 
 

 

 

Tech Tip: If students experience difficulty grabbing and dragging the point, 

check to make sure that they have moved the arrow until it becomes a 

hand (÷) getting ready to grab the point. Press / x to grab the point 

and close the hand ({). When finished moving the point, press d to 

release the point. 

 

Teacher Tip: You might want to break this activity into two different 

lessons, with the vertical translations in questions 1–3 as the first lesson 

and horizontal translations questions 4–7 as the second lesson. 

It is important that students recognize that each tick on the horizontal and 

vertical axis represents one unit. They should also note that the basic 

function is represented by y1  f (x), and the functions obtained by the 

translations are labeled  ( )y f x k2 , where the subscripts are used to 

denote related but different functions. 

 

 

Move to page 1.2. 

 

Part One: y = f(x) + k. 

1. Drag  the point to change the value of k. 
a. What happens to the graph of  ( )y f x k2  as 

the value of k changes? 

 

Answer: As k increases, the graph shifts up. As k decreases, 

the graph shifts down. 

 

 

b. Move the point so that k > 0. Where is the graph of  ( )y f x k2  compared to 1 ( )y f x ? 

 
Answer: For k > 0, the graph of  ( )y f x k2  is above the graph of 1 ( )y f x . 

 
c. Move the point so that k < 0. Where is the graph of  ( )y f x k2  compared to 1 ( )y f x ? 

 
Answer: For k < 0, the graph of  ( )y f x k2  is below the graph of 1 ( )y f x . 
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d. Move the point so that k = 0. Where is the graph of  ( )y f x k2  compared to 1 ( )y f x ? 

 
Answer: For k = 0, the graph of  ( )y f x k2  is on the graph of 1 ( )y f x —the two 

graphs coincide. 

 

TI-Nspire Navigator Opportunity: Screen Capture 

See Note 1 at the end of this lesson. 

 

2. For each of the following statements, indicate if it is True or False, and explain why you 

think so. 
a. When k is negative, the graph of  ( )y f x k2  is below the graph of 1 ( )y f x .  

 
Answer: True. Each point on the graph 1 ( )y f x  is (x, y) and each point on  ( )y f x k2  is  

(x, y + k). When k is negative, you are actually subtracting from the y-value, so the translated point 

is lower than the original point. This is true for all points on the graph. 

 
b. When k is positive, the graph of  ( )y f x k2  is below the graph of 1 ( )y f x . 

 

Answer: False because adding a positive value to f(x) shifts the graph up by that 

amount. 

 
c. There is a value of k that will make part of the graph of  ( )y f x k2  above the 

graph 1 ( )y f x  and the rest below the graph of 1 ( )y f x . 

 

Answer: False because the way k affects one point is the way it will affect all of the 

points. The whole graph moves together for any value of k. 

 

TI-Nspire Navigator Opportunity: Quick Polls 

See Note 2 at the end of this lesson.

Teacher Tip: You might want to point out to students that a vertical shift is 

called a vertical translation. 
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Move to page 2.1. 

 

Part Two: y = f(x – h) 

 

4. Drag the point to change the value of h.  
a. What happens to the graph of 2 ( )y f x h   as 

the value of h changes?  

 

Answer: As h increases, the graph shifts right. As h 

decreases, the graph shifts left. 

 

 

b. Move the point so that h > 0. Where is the graph of 2 ( )y f x h   compared to 1 ( )y f x ? 

 
Answer: For h > 0, the graph of 2 ( )y f x h   is to the right of the graph of 1 ( )y f x . 

 
c. Move the point so that h < 0. Where is the graph of 2 ( )y f x h   compared to 1 ( )y f x ? 

 
Answer: For h < 0, the graph of 2 ( )y f x h   is to the left of the graph of 1 ( )y f x . 

 
d. Move the point so that h = 0. Where is the graph of 2 ( )y f x h   compared to 1 ( )y f x ? 

 
Answer: For h = 0, the graph of 2 ( )y f x h   is on the graph of 1 ( )y f x —the two graphs 

coincide. 

 
5. The graph of 2 ( )y f x h  , when h  0, is a horizontal shift of the graph of 1 ( )y f x . Why does the 

graph shift horizontally? 

 

Answer: A transformation of the form x  x  h  shifts all of the points in the original 

function either right or left because you are subtracting a constant from each x-value. 

 

Teacher Tip: This is a very complicated concept, and one that is counter-

intuitive. Encourage students to think about what happens to points such 

as the zeros of the function or the minimum values of a transformed 

function under the horizontal shift to see what would be necessary in order 

to return to the base (parent) function. You might want to tell students that 

a transformation of this form is called a horizontal translation. 
 

66



 Transformations of Functions 1  TEACHER NOTES 

MATH NSPIRED 
 

©2011 Texas Instruments Incorporated 5 education.ti.com 

 

6.   All of the functions on pages 1.2 through 3.1 were of the absolute value type.  In other words, 
1y x and   2y x h k .  How does the graph of   2 2 1y x  compare to the graph of 

1y x ? Use page 3.1 of the tns document on your handheld to help determine the 

transformations. 

 
Answer: To obtain the graph of   2 2 1y x , the graph of 1y x  is shifted right 2 units and 

down 1 unit. 

 

7.   The vertex of the absolute value graph function is where the graph turns back up or goes back 
down.  What is the vertex of   2 2 1y x ? Check with page 3.1.   

Answer: The vertex is (2,-1) 

 
8.  What is the vertex of   2 3 4y x ?  What is the vertex of   2y x h k  ? 

 

Answer: The vertex is (-3,4) and (h,k) 

 

9. Pages 4.1 and 5.1 use a different type of function. For each transformation in a, b and 
c, describe the changes in the graph of 1 ( )y f x  shown. Then sketch the graph of y2. 

Use pages 4.1 and 5.1 to check answers  

Answers:  

 
a. 2 ( 1)y f x   b. 2 ( ) 2y f x   c. 2 ( 1) 2y f x    

shifts right 1 unit shifts up 2 units shifts right 1 unit, up 2 units 

  

TI-Nspire Navigator Opportunity: Quick Polls 

See Note 3 at the end of this lesson. 

 

Wrap Up 
Upon completion of the discussion, the teacher should ensure that students understand: 
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 The transformation y = f(x) + k on a function y = f(x) will result in a vertical shift, while the 

transformation y = f(x – h) will result in a horizontal shift. 

 How to distinguish between horizontal and vertical translation both graphically and symbolically.  

 When a table has x-values that repeat but different y-values, then it does not represent a function. 

 How to graph a function y = f(x – h) + k given the function y = f(x). 

 Why a transformation of y = (x – h) will shift to the right if h is positive and to the left if h is negative. 

 

 

TI-Nspire Navigator 
Note 1 

Question 1, Screen Capture: Whenever visual patterns from the class are involved, this is an ideal 

application for the Screen Capture feature of TI-Nspire Navigator. 

 

  

Note 2 

Question 2, Quick Poll: Quick Polls are suitable whenever either open or closed questions are asked; 

used with the slideshow feature, they allow students to learn from the contributions (and mistakes) of 

others. Use the True False feature to ask students to submit their answers to questions 2a, b, and c. 

Discuss why and why not. 

  

Note 3 

Question 7, Quick Poll: Use the Open Response feature. Send students the following prompts, one at a 

time, and ask them to tell how the graph of the function that is sent to them differs from the original 

function, y = f(x). Use ‘up’, ‘down’, ‘left’, ‘right’, and how many units in the answers. 

 

1. y = f(x + 2) Answer: left 2 

2. y = f(x) + 2 Answer: up 2 

3. y = f(x – 3) Answer: right 3 

4. y = f(x) – 3 Answer: down 3 

5. y = f(x + 1) – 4 Answer: left 1, down 4 
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Activity Overview:  
This activity describes how to enter data into a Lists & Spreadsheet application and then generate a 
scatter plot of the data using Quick Graph. Information is also provided on graphing the data on a 
separate page using the Data & Statistics application. 
 
 
 
 

Entering Data in a Spreadsheet and Using Quick Graph 

Step 1: Press c and select New Document to start a new 

document. 

Step 2: Choose Add Lists & Spreadsheet. 

Note: To add a Lists & Spreadsheet page to an existing 

document, press / ~ and choose Add Lists & 

Spreadsheet. Alternatively, you may press c and 

select  using the Touchpad. 

 

Step 3: In Column A, press £ on the Touchpad to move to the top 

of Column A. Be sure to move to the top of the column. 

Step 4: Type the list name folds next to the letter A, and press 

·. 

Step 5: Move to the top of column B, enter the list name layers, and 

press ·.  

 

Note: The data entered below are from the “paper folding” activity that many 

teachers use to introduce exponential functions. 

Step 6: Enter data, as shown, into the two lists.  

Place the cursor in cell A1 for Column A or in cell B1 for 

Column B, and enter the first number.  

Note: Pressing · or ¤ will move the cursor to the next 

cell in the column. 
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Step 7: To create a graph, press Menu > Data > Quick Graph. 

The screen will automatically split vertically—the Lists & 

Spreadsheet application remains in the left work area while 

a Data & Statistics application is inserted into the right work 

area. A dot plot appears. This is a plot of the data in the list 

in which the cursor was located when Quick Graph was 

selected. 

 

Note: The dark rectangle around the Data & Statistics 

application work area indicates that the application is active. 

To move from one work area to another, press / e or 

use the Touchpad and press x to select the desired 

application. 

 

 

Step 8: To change the list that is graphed, move the cursor over the 

horizontal axis label. The message “Click or Enter to 

change variable” will appear. 

Step 9: Press x to display the variables—in this case, the names 

of the lists entered in the spreadsheet. Press x or · to 

select the variable folds.  A dot plot of the folds data is 

graphed. 
 

Step 10: Move the cursor to the middle of the left side of the graph 

screen. The message “Click or Enter to add variable” will 

appear. Press x to display the variables and then press ¤ 
to highlight the variable layers. Press x or · to select 

the variable layers. 
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Note: Had both lists been selected before the Quick Graph menu option was 

selected, a scatter plot would have been graphed rather than a dot plot.  

 

• To select multiple lists, place the cursor in a cell in the folds 
column, and continue to press £ until the entire list is 

highlighted. 
• Press and hold g, and press ¢ to highlight both lists. 

• Release the g key. 

• Press Menu > Data > Quick Graph. 
• A scatter plot will be created with the list to the left as the 

independent variable list. 

 

 

 

 

Note: To clear all data in one or more lists, first select the list(s) as described 

above. Then, press Menu > Data > Clear Data. 

 

Graphing Data on a Separate Page Using the Data & Statistics Application  

Step 11: To display the graph on a separate page, first add a Data & 

Statistics page by pressing / ~ and selecting Add 

Data & Statistics.  

 

 

 

Note: The list name displayed next to the word Caption is 

the name of the list in the spreadsheet that comes first 

alphabetically. If categorical data had been entered in the 

spreadsheet, the categorical list name would be displayed 

when the Data & Statistics application page was added. 
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Step 12:  To choose the variable for the horizontal axis, move the 

cursor to the “Click to add variable” message at the 

bottom of the screen. Press x to display the variables.   

 

Step 13: Select the variable folds. 

 

Step 14: Move the cursor to the middle of the left side of the screen. 

When “Click or Enter to add variable” appears, press x 
to display the variables. Select the variable layers. 
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Open the TI-Nspire document 
Trigonometric_Transformations.tns. 
 
In this activity, you will use an observation wheel to apply 
transformations to periodic functions and write an equation for a 
trigonometric function. 

 
 
Move to page 1.2. 
	  

Press / ¢ and / ¡ to 

navigate through the lesson. 
The London Eye is an observation wheel in London that can carry 800 passengers in 32 capsules. It 
turns continuously, completing a single rotation once every 30 minutes. 
1. On the screen, you see a model of the London Eye on the left side and a graph on the right. Click 

on the play button to start the animation. Click the button again to stop it. What type of function 
was created as a result of the animation? 

 
 
2. What does the changing measurement on the left screen represent as the capsule (represented by 

the open circle) moves around the observation wheel? 
 
 
3. What are the units of the x- and y-axes on the right? 
 
 
4. a. What is the maximum height a capsule reaches from the platform?  
 
 

b. The horizontal line halfway between the maximum and minimum of the function is called the 
midline of the graph. What is the equation of the midline? Explain your reasoning. 

 
 

5. The function y = –A · cos(Bx) + D can be used to model the capsule’s height above the platform at 
time x. This is a transformation of a basic cosine curve. 
a. Use your knowledge of transformations to explain why there is a negative sign in front of the 

variable A. 
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b. The variable A represents the amplitude, which is the vertical distance between the midline 

and the maximum or the minimum. What is the amplitude of the “observation wheel” function, 
and how did you find the value? 

 
 
c. Which variable of the equations represents the midline of the function? Explain your reasoning. 
 
 
d. The period of a function is the time it takes to complete one cycle of a periodic function. What 

is the period of the “observation wheel” function, and how is it visible in the graph? 
 
 

6. What characteristic of the observation wheel does the amplitude represent? Explain your reasoning. 
 
 

7. The variable B represents frequency. Frequency is the measure of the arc (in radians) traveled by 
the capsule divided by the time traveled (in minutes). 

 
 

a. What is the measure of the arc traveled by the capsule in one complete revolution? 
 
 
b. How long does it take for a capsule to complete one revolution? 
 
 
c. What is the frequency for the “observation wheel” function? 
 
 

8. Using y = –A · cos(Bx) + D and the variable information found in Question 5, write the equation 
representing the height of a London Eye capsule at time x. Verify your answer by graphing the 
function. 
 
 

9. Imagine the boarding platform for the observation wheel stands 10 feet above the ground. If your 
function takes this height into consideration, what parameters of the equation would change? What 
parameters would stay the same? 
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Math Objectives  
• Students will determine the type of function modeled by the height 

of a capsule on the London Eye observation wheel. 

• Students will translate observational information to use as the 
parameters of a cosine function. 

• Students will determine the amplitude, frequency, period, and 
midline of a cosine function when given information in verbal or 
graphical form. 

• Students will model the height of a capsule on the London Eye by 
writing an equation in the form y = –A · cos(Bx) + D. 

• Students will model with mathematics (CCSS Mathematical 
Practice). 

Vocabulary 
• amplitude 

• frequency 

• midline 

• parameters of a function 

• period 

• periodic function 

• sinusoidal function 

About the Lesson 
• This lesson involves creating an appropriate equation to model 

the height of a capsule on the wheel. 

• As a result, students will: 

• Use a slider to animate the function modeled by the height of 
a capsule on the London Eye observation wheel. 

• Discover the concepts of amplitude, frequency, period, and 
midline. 

• Determine the amplitude, frequency, period, and midline of 
the “observation wheel” function. 

Related Lessons 
• Prior to this lesson: Unit Circle 

TI-Nspire NavigatorTM 
• Use of Document Collection/Quick Poll/Screen Capture will 

allow the teacher to assess student understanding during the 
lesson.  

• Use Screen Capture to examine results.  

 
 

TI-Nspire™ Technology Skills:  
• Download a TI-Nspire 

document 
• Open a document 
• Move between pages 
• Use a slider 
• Click slider arrows to begin an 

animation 
• Move between applications 
• Show the function entry line 
• Insert the equation of a function 

and graph it 

 

Tech Tips: 
• Make sure the font size on your 

TI-Nspire handhelds is set to 
Medium.  

• In the Graphs application, you 
can hide the function entry line 
by pressing / G. 

 

Lesson Materials: 
Student Activity 
• Trigonometric_Transformations

_Student.pdf 
• Trigonometric_Transformations

_Student.doc 

TI-Nspire document 
• Trigonometric_Transformations

.tns 
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Discussion Points and Possible Answers 
 

 
 

Tech Tip: Press d to hide the entry line if students accidentally press 
e. 

 
 

Move to page 1.2. 
 
1. On the screen, you see a model of the London Eye on the 

left side and a graph on the right. Click on the play button to 
start the animation. Click the button again to stop it. What 
type of function was created as a result of the animation? 
  
Sample Answers:	  A sinusoidal function. A cosine function. A periodic function. A 
cyclical function. 

 

TI-Nspire Navigator Opportunity: Screen Capture or Live Presenter 
See Note 1 at the end of this lesson. 

 
2. What does the changing measurement on the left screen represent as the capsule 

(represented by the open circle) moves around the observation wheel? 
 

Teacher Tip: Students should recognize the shape of the graph. Some 
students might recognize the transformations, while others will not. 

 
Answer: The measurement shows the height of a capsule from the platform. 
 

3. What are the units of the x- and y-axes on the right? 
 

Answer: The x-axis represents time in minutes. The y-axis represents height in feet. 
 
4. a. What is the maximum height a capsule reaches from the platform?  
 

Answer: 450 feet 
 

TI-Nspire Navigator Opportunity: Screen Capture or Live Presenter 
See Note 2 at the end of this lesson. 
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b. The horizontal line halfway between the maximum and minimum of the function is 
called the midline of the graph. What is the equation of the midline? Explain your 
reasoning. 

 
Answer: The equation of the midline is y = 225. The maximum height is 450 feet 
and the minimum is 0 feet, resulting in a midpoint of 225. 

 
5. The function y = –A · cos(Bx) + D can be used to model the capsule’s height above the 

platform at time x. This is a transformation of a basic cosine curve. 
a. Use your knowledge of transformations to explain why there is a negative sign in 

front of the variable A. 
 

Answer: The basic cosine function starts at its maximum. This function starts at its 
minimum. The negative represents the reflection about the midline. 

 
b. The variable A represents the amplitude, which is the vertical distance between 

the midline and the maximum or the minimum. What is the amplitude of the 
“observation wheel” function, and how did you find the value? 

 
Answer: The amplitude is 225. This distance from the maximum of 450 to the 
value of the midline is 225. 

 
c. Which variable of the equations represents the midline of the function? Explain 

your reasoning. 
 

Answer: The midline is the variable D, which is 225 in this function. In a basic 
cosine curve, the maximum is 1, the minimum is –1, and the midline is y = 0. In this 
function, the maximum is 450, the minimum is 0, and the midline is 225. Vertical 
shifts are represented as an addition or subtraction from the basic function. 

 
d. The period of a function is the time it takes to complete one cycle of a periodic 

function. What is the period of the “observation wheel” function, and how is it visible 
in the graph? 

 
Answer: The period is 30. Looking at the graph, it takes 60 minutes to complete 
two cycles. Thus, it takes 30 minutes to complete one cycle of the periodic function. 
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6. What characteristic of the observation wheel does the amplitude represent? Explain your reasoning. 
 
Answer: The amplitude represents the radius of the observation wheel. 
 

7. The variable B represents frequency. Frequency is the measure of the arc (in radians) traveled by 
the capsule divided by the time traveled (in minutes). 

 
a. What is the measure of the arc traveled by the capsule in one complete revolution? 
 

Answer: The measure of the arc is 2π. 
 

Teacher Tip: You might have to remind students that the measure of the 
arc is the measure of the central angle, and the length of the arc is the 
distance traveled. Frequency in this example is angular velocity. 

 
b. How long does it take for a capsule to complete one revolution? 
 

Answer: It takes 30 minutes. 
 
c. What is the frequency for the “observation wheel” function? 
 

Answer: Frequency is . 

 
8. Using y = –A · cos(Bx) + D and the variable information found in Question 5, write the equation 

representing the height of a London Eye capsule at time x. Verify your answer by graphing the 
function. 
 

Answer: The equation is y = –225 · cos  + 225. 

 

TI-Nspire Navigator Opportunity: Quick Poll 
See Note 3 at the end of this lesson. 
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9. Imagine the boarding platform for the observation wheel stands 10 feet above the ground. If your 
function takes this height into consideration, what parameters of the equation would change? What 
parameters would stay the same? 

 

Answer: The new equation would be y = –225 · cos  + 235. 

The only parameter that changes is D, the vertical shift. The amplitude and frequency 
stay the same because they are based on the observation wheel, not where it exists 
in space. 

 
 
Extension: 
How can you model the London Eye using a sine function? 

 
 
Wrap Up 
Upon completion of the discussion, the teacher should ensure that students are able to understand: 
• The type of function modeled by the height of a capsule on an observation wheel. 
• Parameters of a cosine function. 
• How to determine the amplitude, frequency, period, and midline of a cosine function when given 

information in verbal or graphical form. 
• How to use parameters to write an equation in the form y = –A · cos(Bx) + D. 
 
TI-Nspire Navigator 
 
Note 1 
Question 1, Screen Capture and Live Presenter 
As students begin this activity, use Screen Capture to be assured that each student is able to play the 
animation. You can choose one student to display their work on this and future problems and discuss the 
results. 
 
Note 2 
Question 3, 4, Screen Capture 
You can choose to use Screen Capture to share the work for these problems.  
 
Note 3 
Whole Document, Quick Poll 
Quick Poll can be used throughout the lesson to assess student understanding. 
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Activity Overview: 
In this activity, the TI-Nspire™ Teacher Software is used to construct a pair of parallel lines cut by a 
transversal and to measure a pair of corresponding angles. 
 
 
 

Steps 

1. Start a new TI-Nspire™ document. 

2. Add a Geometry application page.  

3. To draw a line, select Points & Lines > Line from the Document 

Tools (in the Documents Toolbox). Move the cursor to a location 

near the bottom of the page and click to place a point on the 

page. 

4. Press Shift+J to label the point J. 

5. Move the cursor to the right and click to complete the line. Press 

Esc to exit the Line tool. 

 

To construct a line parallel to a given line, it is necessary to identify a 

point and a line. 

6. From the Documents Tools, select Construction > Parallel. 

7. Move the cursor to the line that passes through point J and click 

to select the line. A ghosted line parallel to the line through point J 

will appear. 

8. Move the cursor away from the line that passes through point J. 

Click to identify a new point and drop the line. 

9. Press Shift+H to label the new point H. Press Esc to exit the 

Parallel tool. 

 

 

10. To draw a transversal to the lines through points J and H, select 

Points & Lines > Line from the Document Tools. 

11. Click to place a point on the screen above the line that passes 

through point H. Press Shift+D to label the point D. 

12. Move the cursor until a line is drawn through the parallel lines. 

13. Click to complete the line. Press Esc to exit the Line tool. 
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14. To mark the points at which the lines intersect, select the tool Points & Lines > Intersection 

Point(s). 

15. Move the cursor to the line that passes through point D, and click to select the line. 

16. Move the cursor to the line that passes through point J, and click to select the line.  

17. The point of intersection will appear. Press Shift+B to label the 

point B. 

18. Move the cursor to the line that passes through point D, and click. 

19. Then, move the cursor to the line that passes through point H, 

and click. 

20. The point of intersection will appear. Press Shift+A to label the 

point A. Press Esc to exit the Intersection Point(s) tool.  

To measure an angle, three points must be selected: the vertex of the angle and a point on each ray that 

forms the angle. The vertex must be the second point selected. 

21. To measure ∡DAH, select Measurement > Angle. 

22. Move the cursor to point D. The phrase point D will appear. Click 

when a “hand” appears and point D becomes bold. 

23. Move the cursor to point A, and click when it becomes bold. 

24. Move the cursor to point H, and click when it becomes bold. 

25. The angle measure will appear but may need to be moved to the 

appropriate location. 

26. To move the angle measure to the appropriate location, first 

press Esc to exit the measurement tool. 

• Move the cursor over the angle measure.  

• The arrow should become a hand (÷) getting ready to grab 

the measure, and the word text should be displayed. 

• Hold down the left click of the mouse and drag the angle 

measure. 

• Release the left click to place the measure at the desired 

location. 

27. Next, measure ∡ABJ and place the angle measure at the 

appropriate location. 

 

 

 

Note: If a tool is active, an icon for that tool appears in the upper-left corner of the screen. Press Esc to 

exit any tool before attempting to drag text or an object. 
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Open the TI-Nspire document Area_Formulas.tns. 

 

How is the area of a parallelogram related to the area of a 

rectangle? How are triangles and trapezoids related to 

parallelograms? This lesson lets you explore the relationships 

among their area formulas. 

 

 

Move to page 1.2. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

1. Click £ to show the dimension labels of the rectangle. 

a. What are the labels for the dimensions of the given rectangle? 

 

b. What is the formula for the area of the rectangle in terms of base and height? 

 

 

2. Drag the top left or bottom right vertex to change the dimensions of the rectangle. If you 

change the dimensions of the rectangle, would this change the formula for the area of 

the rectangle? 

 

 

Move to page 1.3. After reading the instructions, move to page 1.4. 

 

3. a. How do the base and height of the parallelogram compare to the base and height 

of the rectangle at the top of the screen? 

 

b. Move point H or point B. Describe the changes that occur in the rectangle and the 

changes in the parallelogram. 

 

 

4. Drag point P to the right as far as you can.  

a. Explain why the new figure on the bottom of the screen is a rectangle. 

 

b. What does this tell you about the area of the original parallelogram? 

 

c. Why do the parallelogram and the rectangle have the same area? 

 

d. What could be a formula for the area of the parallelogram? 
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Move to page 2.1. After reading the instructions, move to page 2.2. 

 

5. a. How do the base and height of the triangle compare to the base and height of the 

parallelogram at the top of the screen? 

 

b. Move point H or point B on the parallelogram. Describe the changes that occur in the 

parallelogram and the changes in the triangle. 

 

 

6. Rotate point Q until it is as far right as possible. 

a. What type of figure is formed? 

 

b. How does the area of the original shaded triangle compare to the area of the 

parallelogram? 

 

 

7. If the area of a parallelogram is base times height, then what could be a formula for the area 

of the triangle? 

 

Move to page 3.1. After reading the instructions, move to page 3.2. 

 

8. Rotate point R until it is as far right as possible. 

a. What type of figure is formed? 

 

b. How is the base of the parallelogram related to the trapezoid? 

 

c. Write an expression to represent the area of the parallelogram—either the parallelogram 

on the top of the screen or the newly formed parallelogram at the bottom of the screen. 

 

9. How does the area of the original shaded trapezoid compare to the area of the parallelogram? 

 

 

10. If the area of a parallelogram is base times height, then what could be a formula for the area of the 

trapezoid? 
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11. For each problem below: 

• Draw the figure. 

• Write a formula that could be used to find the area of each figure. 

• Use your formula to find the area of each figure. 

a. A parallelogram with base of 7.5 units and height of 8 units 

 

b. A triangle with base of 13 units and height of 4 units 

 

c. A trapezoid with height of 5 units, and bases of 12 units and 6 units 
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Math Objectives  
• Students will be able to describe how the area of a parallelogram 

relates to the area of a rectangle with the same base and height. 

• Students will be able to describe how the area of a triangle 

relates to the area of a parallelogram with the same base and 

height. 

• Students will be able to describe how the area of a trapezoid 

relates to the area of a parallelogram with the same height and 

with a base equal to the sum of the bases of the trapezoid. 

• Students will be able to use relationships to compute the areas of 

parallelograms, triangles, and trapezoids given their dimensions. 

• Students will reason abstractly and quantitatively (CCSS 

Mathematical Practice). 

• Students will look for and make use of structure (CCSS 

Mathematical Practice). 

 

Vocabulary 
• rectangle 

• parallelogram  

• triangle 

• trapezoid 

 

About the Lesson 
Students will: 

• Observe the relationships between figures and compare the 

areas of the figures. 

• Formulate expressions to compute the area of parallelograms, 

triangles, and trapezoids. 

 

TI-Nspire™ Navigator™ System 
• Quick Poll 

• Screen Capture 

 
 

TI-Nspire™ Technology Skills: 

• Download a TI-Nspire 

document 

• Open a document 

• Move between pages 

• Grab and drag a point 

 

Tech Tips:  

• Make sure the font size on 

your TI-Nspire handhelds is 

set to Medium.  

• You can hide the function 

entry line by pressing / 
G. 

 

Lesson Materials: 
Student Activity 
Area_Formulas.pdf 
Area_Formulas.doc 

TI-Nspire document  
Area_Formulas.tns 

 

Visit www.mathnspired.com for 

lesson updates and tech tip 

videos. 
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Discussion Points and Possible Answers 
 

 

 

Tech Tip: If students experience difficulty dragging a point, check to make 

sure that they have moved the arrow until it becomes a hand (÷) getting 

ready to grab the point. Then press /x to grab the point and close the 

hand ({). When finished moving the point, press d to release the point. 

 

Move to page 1.2. 

 

1. Click £ to show the dimension labels of the rectangle. 

a. What are the labels for the dimensions of the given 

rectangle? 

 

Answer: base and height 

 

b. What is the formula for the area of the rectangle 

in terms of base and height? 

 

Answer: Area = base × height 

 

 
 

Teacher Tip: You may want to discuss the different vocabulary (labels) 

used for the dimensions of the rectangle (width and height, length and 

width, and base and height). For this activity, the dimensions will be 

referred to as base and height. 
 

2. Drag the top left or bottom right vertex to change the dimensions of the rectangle. If you 

change the dimensions of the rectangle, would this change the formula for the area of 

the rectangle? 

 

 Answer: No, it would still be Area = base × height. 

 

TI-Nspire Navigator Opportunity: Quick Poll 

See Note 1 at the end of this lesson.  
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Move to page 1.3. After reading the instructions, move to page 

1.4. 

 

3. a. How do the base and height of the parallelogram compare to 

the base and height of the rectangle at the top of the 

screen? 

 

Answer: The base of the parallelogram = the base of the 

rectangle.  

The height of the parallelogram = the height of the rectangle. 

 

 

b. Move point H or point B. Describe the changes that occur in the rectangle and the 

changes in the parallelogram. 

 

Answer: As the base of the rectangle changes, the base of the parallelogram changes 

accordingly. As the height of the rectangle changes, the height of the parallelogram changes 

accordingly. 

 

4. Drag point P to the right as far as you can.  

a. Explain why the new figure on the bottom of the screen is a 

rectangle. 

 

Answer: The new figure is a quadrilateral with right angles. 

 

  

b. What does this tell you about the area of the original parallelogram? 

 

Answer: The original parallelogram has the same area as the rectangle.  

 

c. Why do the parallelogram and the rectangle have the same area? 

 

Answer: They have the same base and height. 

 

d. What could be a formula for the area of the parallelogram? 

 

Answer: Area = base × height 
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Teacher Tip: Make sure students understand they can’t always just 

measure the sides to find area. You could ask students probing questions 

such as: Is a side length ever a height? If you know the area, can you find 

the base and height? 

 

Move to page 2.1. After reading the instructions, move to 

page 2.2. 

 

5. a. How do the base and height of the triangle compare 

to the base and height of the parallelogram at the top 

of the screen? 

 

Answer: The base of the triangle = the base of the 

parallelogram.  

The height of the triangle = the height of the 

parallelogram. 

 

b. Move point H or point B on the parallelogram. Describe the changes that occur in the 

parallelogram and the changes in the triangle. 

 

Answer: As the base of the parallelogram changes, the base of the triangle changes 

accordingly. As the height of the parallelogram changes, the height of the triangle changes 

accordingly. 

 

6. Rotate point Q until it is as far right as possible. 

a. What type of figure is formed? 

 

Answer: a parallelogram 

 

b. How does the area of the original shaded triangle 

compare to the area of the parallelogram? 

 

Answer: The area of the triangle is half the area of the 

parallelogram. (It takes two triangles to equal the 

parallelogram.) 
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7. If the area of a parallelogram is base times height, then what could be a formula for the area 

of the triangle? 

 

 Answer: Area = 
1

2
× base × height 

 

CCSS Mathematical Practice: Students will reason abstractly and 

quantitatively. 

Mathematically proficient students will not only use the formula for the area 

of the triangle but also attend to how the formula is related to the area of a 

parallelogram with equal base and height. 

 

Move to page 3.1. After reading the instructions, move to 

page 3.2. 

 

8. Rotate point R until it is as far right as possible. 

a. What type of figure is formed? 

 

Answer: a parallelogram 

 

b. How is the base of the parallelogram related to the trapezoid? 

 

Answer: The base of the parallelogram is the sum of the bases 

of the trapezoid, base1 + base2. 

 

 
 

c. Write an expression to represent the area of the parallelogram—either the parallelogram on the 

top of the screen or the newly formed parallelogram at the bottom of the screen. 

 

Answer: Area of the parallelogram = (base1 + base2) × height 

 

TI-Nspire Navigator Opportunity: Screen Capture 

See Note 2 at the end of this lesson.  

9. How does the area of the original shaded trapezoid compare to the area of the parallelogram? 

 

 Answer: The area of the trapezoid is half the area of the parallelogram. 
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10. If the area of a parallelogram is base times height, then what could be a formula for the area of the 

trapezoid? 

 

 Answer: Area of the trapezoid = 
1

2
 (base1 + base2) × height 

 

CCSS Mathematical Practice: Students will look for and make use of 

structure. 

Mathematically proficient students will look closely to see how the 

parallelogram on top is composed of the trapezoids on the bottom. They 

will discern the pattern from the previous problems to generalize the area of 

the trapezoid. 

 

Teacher Tip: The following problems are designed to help students 

correctly associate specific shapes with the appropriate formula for area. In 

addition, the problems provide an opportunity for you to assess their 

understanding of how the variables and formulas are used. Students are 

expected to substitute values in the correct formula to find the area. 
 

11. For each problem below: 

• Draw the figure. 

• Write a formula that could be used to find the area of each figure. 

• Use your formula to find the area of each figure. 

 

a. A parallelogram with base of 7.5 units and height of 8 units 

 

Answer: Area = base × height 

Area = 7.5 units × 8 units = 60 square units (60 u2) 

 
 

b. A triangle with base of 13 units and height of 4 units 

 

Answer: Area = 
1

2
 × base × height 

Area =  × 13 units × 4 units = 26 square units (26 u2) 

 
 

1

2
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c. A trapezoid with height of 5 units, and bases of 12 units and 6 

units 

 

Answer: Area = 
1

2
(base1 + base2) × height 

Area = 
1

2
 (12 + 6) units × 5 units = 45 square units (45 u2) 

 
 

TI-Nspire Navigator Opportunity: Quick Poll 

See Note 3 at the end of this lesson.

 
 
Wrap Up 
Upon completion of the discussion, the teacher should ensure that students: 

• Understand how the area of a parallelogram relates to the area of a rectangle with the same 

base and height. 

• Understand how the area of a triangle relates to the area of a parallelogram with the same 

base and height. 

• Understand how the area of a trapezoid relates to the area of a parallelogram with the same 

height and with base equal to the sum of the bases of the trapezoid. 

 

TI-Nspire Navigator 
Note 1 

Question 2, Quick Poll:  

Send students the following Always/Sometimes/Never Quick Poll, and then have 

students justify their responses. 

Rectangles with the same perimeter have the same area. 

Answer: Sometimes. 3 rectangles with a perimeter of 12 units could have dimensions 2 × 4, 

4 × 2, and 1 × 5. 

 

 

Note 2 

Question 8, Screen Capture:  

Have students change the base and/or height of the trapezoid. Show a Screen Capture to 

the class so that students can see the relationship between the trapezoid and parallelogram 

above it for shaped trapezoids with various shapes. 
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Note 3 

Question 11, Quick Poll:  

Have students send in their responses to the area problems using an Open Response 
Quick Poll. 
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Activity Overview:  
This activity describes how to enter Categorical data into a Lists & Spreadsheet application and 
then use a Summary Chart to generate a graph of the data on the same screen. 
 
 
 

Preparing the Document 

Step 1: Press c, and select New Doc to open a new document.   
Step 2: Choose Add Lists & Spreadsheet. 
Note:   To add a Lists & Spreadsheet page to an existing document, press / ~ and choose 

Add Lists & Spreadsheet. Alternatively, you may press c and select  using the 
Touchpad. 

 

Entering the Categorical Data 

Step 1: In Column A, press ` on the Touchpad to move to the top 
of Column A. 

Step 2: Type the list name color next to the letter A, and press 

·. 

Step 3: Press ¤ on the Touchpad and move down to cell A1. 

Categorical data must be entered using quotation marks. 

 

Step 4: Press /    x for the quotation marks and type the word 

red, then press ·. 

Step 5: In cell A2, press /  x for the quotation marks and type the 

word blue, then press ·. 

Step 6: In cell A3, press / x for the quotation marks and type 

the word green, then press ·. 

 

Entering the Frequency Data 

Step 1: Press ¢ to move to Column B. then press £ four times to 

move to the top of the column. Enter the list name amount, 

and press ·. 

Step 2: Press ¤ on the Touchpad and move down to cell B1. 

Enter the data {17, 8, 13} in cells B1-B3.  
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Step 3: To create a graph, move the cursor to one of the cells in 

Column A and select Menu > Data > Summary Chart. 

 

 

 

 

 

 If needed, use e and Click x to select the X List 

(color) and the Summary List (amount) as shown. 

 

 

 

 The screen will automatically split—the Lists & Spreadsheet 

application remains on the left while a Data & Statistics 
application appears on the right. A Bar Graph will appear.  

 

 

 

 

    If you wish, you may color the bars to match the colors 
listed. Select a bar by clicking on it and use / b, 

choose color and then click on the color palette. 

 

 

 

 

 To change to a Pie Chart, press b and choose  

Plot Type > Pie Chart. 

 

 
 

Note: The dark rectangle around the Data & Statistics application work area indicates that 

the application is active. To move from one work area to another, press /  e or 

use the Touchpad to move to and press a to select the desired application. 
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Open the TI-Nspire™ document Maximize_Area_Garden.tns. 

 

A garden with a rectangular shape is attached to a barn. Exactly 

three sides of the garden must be fenced, and 22 meters of 

fencing will be used. What are the dimensions of the garden with 

the maximum possible area? 

 

Move to page 1.2. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

1. As directed on page 1.2, draw a sketch of each of your five different gardens. Be sure 

to use a variety of width values. Remember that only three sides of the garden are to 

be fenced and that you will use 22 meters of fencing. 

 

 

2. Record the width, length, and area of each garden in the table below. Be sure to 

include appropriate units of measurement. 

 

Sketch no. Width Length Area 

1 
 
 

  

2 
 
 

  

3 
 
 

  

4 
 
 

  

5 
 
 

  

 

 

3. Considering the data from your sketches, describe what happens to the area of the 

garden as the width of the garden increases. 
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4. Compare your answer to question 3 with the answers of other students in your class. 

Use the class data to describe what happens to the area of the garden as the width of 

the garden increases. 

 

 

 

 

5. If the goal is to maximize the area of the garden, which of your garden sketches will be 

best to use? Why? 

 

 

 
 

Move to page 1.3. 

 

6. On page 1.3, enter the width and area data from each of your five garden sketches into 

the spreadsheet in the lower left work area of the screen.  

 

Note: Press / e to move from one work area on the screen to another, or move the 

cursor to that region of the screen with the Touchpad and press x. 
 

 

7. As you enter data in the spreadsheet, a scatter plot of the data set will be graphed. 

Describe the shape of the plot. 

 
 

 

8. Write a formula for the amount of fencing used in terms of the width and length of the 
garden.  

 

 

9. Rearrange the formula from question 8 to solve for the length (l) of the garden in terms 

of the width (w). 
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10. Write an equation that could be used to determine the area (A) of the garden if you only know 

the width (w) of the garden. Hint: Use your answer from question 9 that expresses the length 

of the garden in terms of the width. 

 
 

 

11. Let x represent the width of the garden and let f(x) represent the area of the garden in 

terms of its width. Write a function to express the area of the garden in terms of the 

width of the garden. 

 
 

 

12. What values can be used for the width of the garden in this problem? In other words, 

what is the domain of your function? 

 
 

 

Move to page 1.4. 

 

13. On page 1.4, graph your function with the scatter plot on a full page. 

 Press e to display the entry line (Alternate methods: Click on the chevron or press / G.) 

 f1(x)= is displayed. Enter your function definition and then press ·. 

 

 
14. If the graph of the function does not fit your data, recheck your data and your answer for question 11. 

 
 

15. What are the width and area of the garden with the maximum possible area? 

 
 

16. How did you determine the maximum area of the garden? 
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17. Suppose that a rectangular garden of this type (using 22 meters of fencing) has an 

area of 52.5 square meters. 

a. What width and length could be used to form a garden with this area? (Add pages, 

as needed, to the TI-Nspire™ document to solve this problem.) 

 

 

b. Describe the method you used to find the width and length. 

 

 

 

18. Jackie has 44 meters of fencing to use to make a rectangular garden (with exactly 

three fenced sides) that is attached to a barn. How would the maximum area of her 

garden compare to the maximum area of the same type of garden that uses 22 meters 

of fencing? Justify your answer. (Add pages, as needed, to the TI-Nspire™ document 

to solve this problem.) 

 

 

Extension: 
 

1. Suppose that a rectangular garden is not attached to a barn. You will still use 22 

meters of fencing, but four sides must be fenced. What width and length do you think 

the garden should have to produce the maximum area? Make a conjecture, and explain 

your reasoning.  
 
 
 
 

2. Use Problem 2 in the TI-Nspire™ document to explore the dimensions of this type of 

garden. Add pages, as needed, to determine the width and length that will result in a 

garden with the maximum area. 

 

 
 

3.  How does the maximum area of a garden with four fenced sides compare to the 

maximum area of a garden that is attached to a barn? Compare your answer to those 
of your classmates. 
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Math Objectives 
 Students will determine the relationship between the width and 

length of a garden with a rectangular shape and a fixed amount of 

fencing. The garden is attached to a barn, and exactly three sides 

of the garden will be fenced.  

 Students will determine a formula that can be used to compute 

the area of the garden when given the width. 

 Students will find the dimensions of the garden that has the 

maximum possible area. 

 Students will make sense of problems and persevere in solving 

them (CCSS Mathematical Practice). 

 

Vocabulary 
 perimeter 

 area 

 maximize 

 conjecture 

 

About the Lesson 
 In this activity, students explore the area of a garden with a 

rectangular shape that is attached to a barn. Exactly three sides 

of the garden must be fenced. Students will sketch possible 

gardens and enter their data into a spreadsheet. 

 As a result students will: 

 Graph the data, find an equation for the area of the garden in 

terms of its width, find the maximum area of the garden, and 

solve related problems. 

 Determine that, given a fixed perimeter, the area enclosed 

depends upon the dimensions chosen. 

 The extension problem provides an opportunity for students to 

explore a different scenario—a garden with a rectangular shape 

that must be fenced on all four sides. Problem 2 in the  

TI-Nspire™ document may be used to explore this scenario. 

 

 
 

 
 

TI-Nspire™ Technology Skills: 

 Download a TI-Nspire™ 

document 

 Open a document 

 Move between pages 

 Grab and drag a point 

 Enter data into a spreadsheet 

 

Tech Tips:  

 Make sure the font size on 

your TI-Nspire™ handheld is 

set to Medium.  

 You can hide the function 

entry line by pressing  

/ G. 

 

Lesson Materials: 
Student Activity 
Maximize_Area_Garden_ 
Student_pdf 
Maximize_Area_Garden_ 
Student_doc 

 

TI-Nspire™ document  
Maximize_Area_Garden.tns 
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Discussion Points and Possible Answers 
 

 

 

 

Move to page 1.2. 

 

1. As directed on page 1.2, draw a sketch of each of your five 

different gardens. Be sure to use a variety of width values. 

Remember that only three sides of the garden are to be fenced 

and that you will use 22 meters of fencing. 

  

2. Record the width, length, and area of each garden in the table below. Be sure to 

include appropriate units of measurement. 

 

Sample Answers: Answers will vary—one possible set of answers: 
 

Sketch no. Width Length Area 

1 2 m 18 m 36 m2 

2 4 m 14 m 56 m2 

3 6 m 10 m 60 m2 

4 7 m 8 m 56 m2 

5 8 m 6 m 48 m2 

 

 

3. Considering the data from your sketches, describe what happens to the area of the 

garden as the width of the garden increases. 

 

Sample Answers: Answers will vary. Students might say that the area increases, 

decreases, or both increases and decreases. 

 

Teacher Tip: Depending on the values that students choose for the width, 

they might conclude that the area values always increase or always 

decrease. Consequently, question 4 was included so that students could 

compare their data to that of other students. 
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4. Compare your answer to question 3 with the answers of other students in your class. 

Use the class data to describe what happens to the area of the garden as the width of 

the garden increases. 

 

Sample Answers: Students should discover that for a large sample of different widths, 

as the width of the garden increases, the area of the garden first increases and then 

decreases. 

 

5. If the goal is to maximize the area of the garden, which of your garden sketches will be 

the best to use? Why? 

 

Sample Answers: Answers will vary. Students should choose their garden sketch with 

the largest area but might have other ideas about the “best” garden after comparing 

their sketches with those of other students. 

 

Move to page 1.3. 

 

6. On page 1.3, enter the width and area data for each of your five 

garden sketches into the spreadsheet in the lower-left work area 

of the screen. 

 

Sample Answers: Values for the width and area shown in the 

table in question 2 have been entered in the spreadsheet. 

 

Note: Press / e to move from one work area on the 

screen to another, or move the cursor to that region of the 

screen with the Touchpad and press x. 

 

 

Tech Tip: The active work area will have a bold outline.  

 
 

Teacher Tip: Remind students to pay close attention to the list names in 

the spreadsheet and to enter their data into the appropriate lists. 

 
 

Teacher Tip: Students might need verbal prompts to notice that the  

x-values of the ordered pairs of the points always increase from left to right 

while the y-values first increase and then decrease. 
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7. As you enter data in the spreadsheet, a scatter plot of the data set will be graphed. 

Describe the shape of the plot. 

 

Sample Answers: Answers may vary, depending on the data that students have 

entered in their spreadsheets. If they have a good variety of points (a mix of width 

values that includes both small and large values), students should notice that the data 

points “rise” and then “fall” as you follow the graph from left to right  

 
 
8. Write a formula for the amount of fencing used in terms of the width and length of the garden. 

 

Answer: 2w + l = 22 or l + 2w = 22 or an equivalent formula 

 

9. Rearrange the formula from question 8 to solve for the length (l) of the garden in terms 

of the width (w). 

 

Answer: l = 22 – 2w or 22 – 2w = l or an equivalent formula 

 

10. Write an equation that could be used to determine the area (A) of this garden if you 

only know the width (w) of the garden. Hint: Use your answer from question 9 that 

expresses the length of the garden in terms of the width. 

 

Answer: A = w(22 – 2w) or A = 22w – 2w2 or an equivalent formula 

 

11. Let x represent the width of the garden and let f(x) represent the area of the garden in 

terms of its width. Write a function to express the area of the garden in terms of the 

width of the garden. 

 

Answer: f(x) = x(22 – 2x) or f(x) = 22x – 2x2 or an equivalent formula 

 

12. What values can be used for the width of the garden in this problem? In other words, 

what is the domain of your function? 

 

Answer: The width must be greater than 0 meters and less than 11 meters, or  

0 < x < 11. 
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Move to page 1.4. 

13.  On page 1.4, graph your function with the scatter plot on a full 

page. 

 Press e to display the entry line (Alternate methods: 

Click on the chevron or press / G.) 

 f1(x) = is displayed. Enter your function 

definition and then press ·. 

Note: The scatter plot label (width, area) and the 

function label were moved. 

 
14. If the graph of the function does not fit your data, recheck your 

data and your answer for question 11. 

 

 

15. What are the width and area of the garden with the maximum possible area? 

 

Answer: width = 5.5 meters and area = 60.5 square meters 

 

16. How did you determine the maximum area of the garden? 

 

Sample Answers: Answers will vary as students have a variety of methods to find the 

maximum area. Some students may trace on their function while others may find the 

vertex. 

 

Teacher Tip: If students use a table, it’s important to check that they 

change the Table Step value for the width and that they understand that a 

table might not provide an accurate result. Depending on what students 

have previously learned about quadratic functions, they might know that 

the vertex of a quadratic function yields the maximum or minimum function 

value. Aside from traditional methods of finding the vertex, other methods 

for solving this problem are included in the Tech Tips at the end of this 

document. 
 

17. Suppose that a rectangular garden of this type (using 22 meters of fencing) had an 

area of 52.5 square meters. 

a. What width and length could be used to form a garden with this area? (Add pages, 

as needed, to the TI-Nspire™ document to solve this problem.) 

 

Sample Answers: width = 3.5 m and length = 15 m; or width = 7.5 m and length = 

7 m 
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b. Describe the method you used to find the width and length. 

 

Sample Answers: Methods for finding the width will vary. See the Teacher Tip below. 

 

Teacher Tip: There are many ways to solve this problem. The methods 

include the following: 

1. Graph the function f2(x) = 52.5 with the graph of the area function. 

Find the points of intersection of the graphs. 

2. Add a point to the graph of the function. When the y-value of the 

point’s ordered pair is changed to 52.5, the value of x that results in 

this function value is computed.  

3. Use the Numerical Solver to find the width. 

4. Change the Table Step value in the function table until values of x 

(width) that produce the desired area are found. 

5. Set up the appropriate equation, and use the quadratic formula to 

solve for the width.  

 

(Tech Tips for some of these methods can be found at the end of this 

document.) 
 

18. Jackie has 44 meters of fencing to use to make a rectangular garden (with exactly 

three fenced sides) that is attached to a barn. How would the maximum area of her 

garden compare to the maximum area of the same type of garden that uses 22 meters 

of fencing? Justify your answer. (Add pages, as needed, to the TI-Nspire™ document 

to solve this problem.) 

 

Answer: The area of Jackie’s garden would be four times the area of the garden with 

22 meters of fencing. Methods similar to those used for the solution for the garden with 

a perimeter of 22 meters can be used to solve this problem. 

 

Extension: 

1. Suppose that a rectangular garden is not attached to a barn. You will still use 22 meters of 

fencing, but four sides must be fenced. What width and length do you think the garden should 

have to produce the maximum area? Make a conjecture, and explain your reasoning. 

 

Sample Answers: Answers will vary. Some students might correctly guess that the 

sides should have equal lengths. 

105



 Maximizing the Area of a Garden  TEACHER NOTES 

TI PROFESSIONAL DEVELOPMENT  
 

©2011 Texas Instruments Incorporated 7 education.ti.com 

 

2. Use Problem 2 in the TI-Nspire™ document to explore the dimensions of this type of 

garden. Add pages, as needed, to determine the width and length that will result in a 

garden with the maximum area. 

 

 Answer: width = 5.5 m, length = 5.5 m, and area = 30.25 m2 

 

Tech Tip: The rectangle on page 2.2 displays various dimensions and 

area values as the students drag the point. The spreadsheet is set up for 

automated data capture. To view the data points in a scatter plot, students 

will need to add a Graphs or Data & Statistics application page and set up 

the plot. 
 

Teacher Tip: The perimeter equation is 2w + 2l = 22, and the equation for 

the area in terms of the width is A = w(11 – w). The maximum value of the 

area function can be found using any of the strategies described for the 

other area maximization problem in this activity. 
 

3. How does the maximum area of a garden with four fenced sides compare to the 

maximum area of a garden that is attached to a barn? Compare your answer to those 

of your classmates. 

 

 Answer: The maximum area of the rectangular garden with four fenced sides is one-

half the maximum area of the rectangular shaped garden that was attached to a barn. 

 

Teacher Tip: Students might observe that this area is one-half the area 

found in the area maximization problem. Encourage them, if time permits, 

to see if this relationship holds for perimeters other than 22 meters. Ask 

students to form a conjecture about whether this relationship is always 

true. 

 

This relationship can be proved using calculus. Let some constant k 

represent the fixed perimeter. It can be determined that the maximum area 

of the rectangular figure with four fenced sides and perimeter k is k2/16. 

When three sides are fenced, as described in the problem with one side of 

the garden attached to the barn, the maximum area of the rectangular 

figure with perimeter k is k2/8. 
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Additional Tech Tips for this Activity 
 

 

 

Tech Tip: Tracing on a Function 

Students can trace on their function to determine the 

maximum function value. 

 

1. Select Menu > Trace > Graph Trace. 

 If both a scatter plot and a function have been graphed, the 

Graph Trace command will display the coordinates of the 

first ordered pair plotted in the scatter plot. Press £ or ¤ to 

move to the graph of the function and display a function 

value.   

 Then, use the right ¢ or left ¡ arrow keys to trace on the 

function. The window will adjust automatically. 

 

 

 When the maximum value of the function is approached, the 

tracing point moves to the maximum function value and the 

word maximum is displayed. 

 The coordinates of this point are displayed in the lower-right 

corner of the screen. 

 

2. To change the Trace Step, select Menu > Trace > Trace Step. 

 The current Trace Step is Automatic. 

 If desired, enter a Trace Step value, press e to move to 

OK, and press ·. 

 

3. To exit the tracing mode, press d. 

 

 

 
Tech Tip: Adding a Function Table 

1. To add a Function Table, select Menu > View > Show Table. 

(The shortcut is / T.) 

 When the Table work area is selected (outlined in bold), the 

Table Start and the Table Step values may be edited. 

 

2. Select Menu > Table > Edit Table Settings. 
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Tech Tip: Computing a Regression Equation 

1. To compute a regression equation, first add a page by pressing 
/ ~. Select Add Calculator. 

   

2. Select Menu > Statistics > Stat Calculations > Quadratic 

Regression. 

 
3. Press x to display the list names, and choose width for the X 

List. 

 

4. Press e to move to Y List. 

 

5. Press x and choose area for the Y List. 

 

6. Press e to move to OK, and press x or ·. 

 

 

Note: A regression equation can also be computed in a Lists & 

Spreadsheet application. The advantage of that method is that if 

data are changed or additional data added, the regression 

equation is updated. 

 
 

Tech Tip: Graphing the Regression Equation 

1. To graph the regression equation, first return to a page that 

contains a graph of the data by pressing / ¡. Be sure that the 

Graphs work area is active by clicking on that region of the screen.  

 

2. Press e to display the entry line. f3(x) = is displayed. 

 

3. Press the up arrow £ to display f2(x), the regression equation. 

 

4. Press · to graph the regression equation. 
 

5. Follow the steps described above to trace on the regression 
equation. 
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Tech Tip: Using Numerical Function Maximum 

This menu option will determine the value of the independent 

variable that produces the maximum function value. 

 

1. To compute the value on a new Calculator page, press  
/ ~ and choose Add Calculator. Select Menu > 

Calculus > Numerical Function Maximum.  

 

 

2. On the line showing nfMax( ), type f1(x), x between the 

parentheses and press ·. The function value at this value of 

x can be computed as shown. 

 

Note: f1(x), the function that students should have first entered 
on page 1.4, is used instead of the regression equation. 

 

 

 
 

 

Tech Tip: Method 1 in the Teacher Tips for Question 17 

Note: These screenshots are shown in a new problem. This 

Problem 2 is not related to Problem 2 in the TI-Nspire™ 

document. 

 

Method 1: Graph the function f2(x) = 52.5 with the graph of the area 

function (f1(x)). Find the points of intersection of the 

graphs. 

 

1. Select Menu > Points & Lines > Intersection Point(s). 
 

2. Move the cursor close to one of the graphs and press x or 
·. 

 

 
 

 
 

3. Move the cursor near the second graph and press x or ·. 

Both points of intersection are displayed. 

 

4. Press d to exit the Intersection Point(s) tool. 
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Tech Tip: Method 2 in the Teacher Tips for Question 17 

Method 2: Add a point to the graph of the function. When the y-value 

of the point’s ordered pair is changed to 52.5, the value of 

x that results in this function value is computed. 

 

1. To add a point to the graph of the function, select Menu > 

Points & Lines > Point On. 

 

2. Click twice on the graph of the function. 

 

3. Press d. 

 

4. Move the cursor over the y-value of the point, and press · 

twice to open a text box. 

 

5. Press . to erase the current value. 

 

6. Enter 52.5, and press ·. 

 

7. Place a point to the right of the vertex, and repeat 

the process to obtain the second solution. 

 

 
 

 
 

 

 
Tech Tip: Method 3 in the Teacher Tips for Question 17 

Method 3: Use the Numerical Solve tool to find the width. 

 

1. Add a Calculator page by pressing / ~ and choosing Add 

Calculator. 

 

2. Select Menu > Algebra > Numerical Solve. 

 

3. On the line that shows nSolve( ), enter 22x – 2x2 = 52.5, x 

between the parentheses and then press ·.  
(Alternatively, enter nSolve(f1(x) = 52.5, x.) 

 
4. To solve within a certain domain, include the left and right 

endpoints of the domain as shown. 
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Activity Overview: 
In this activity, you will model the laying of a cable 
from a power plant on one side of river to a factory 
on the opposite bank of the river. The river is 500 
meters wide and the factory is 1200 meters 
downstream from a point on the riverbank directly 
across from the power plant. It costs $20/m to lay 
the cable under the river and $12/m to lay the 
cable along the riverbank. 

This activity is written for Computer View to utilize 
the additional screen space. If the file is to be sent 
to students, create the document in Handheld 
View. 
 
 
 
 

Step 1: Start a new TI-Nspire™ document. 

Step 2: Add a Notes application page. 

Step 3: Press View and select Computer. 

Step 4: From the Document Tools, select Insert  > Math Box.  

Note:  The shortcut for a Math Box is shown in the Insert menu. For 

a Mac, this will appear as Cmd + M. On a PC, the shortcut is 

Ctrl + M. 

 

 

Step 5: Define the variables needed for the problem. After typing a 

variable name, type := (a colon followed by an equals sign) 

to assign a value to a variable. Press Enter after typing the 

variable assignment. 
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Step 6: Follow the directions in Step 5 to define all variables as shown in the screen capture below. 

(Note that the initial distance from point A to point C is defined as 0 meters.) 

 The variables are: 

 width is the width of the river. 

 length is the distance downstream (from point A to the factory). 

 ac is the distance from point A to point C. 

 bank is the distance from point C to point F. 

 river is the distance from point P to point C. 

 rivercost is the cost per meter of laying cable under the river. 

 bankcost is the cost per meter of laying cable along the bank. 

 total is the total cost for laying the cable. 

 

 

 

 

 

 

 

Step 7: The distance from point A to point C (ac) was defined as 0 

meters. This represents the situation in which the cable is 

laid directly across the river. Edit the value of ac by clicking 

on the 0 in the assignment statement. Change the value of 

ac to 1200 and press Enter. 
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Step 8:  The total cost in Step 7 represents the cost of laying a cable directly from the power plant 
to the factory. Note the change in the total cost and compare this to the first situation. 

 

 

Step 9:    Next, change the placement of the cable (point C) on the 

factory side of the bank so that it is placed halfway between 

point A and the factory. 

 

 

 

 

Step 10:    The new total cost is less than the cost of laying the cable directly across the river or 

laying the cable from the power plant directly to the factory. Determine the location for the 

placement of the cable (point C) that will minimize the total cost of laying the cable. 

 

 

 

Possible tasks for students: 

1. Continue to edit the value for ac in order to find the minimum cost of laying a cable in this 
situation. 

2. Engineers have found a way to lower the costs of laying cable. It now costs $15/m to lay the 

cable under the river and $10/m to lay cable along the riverbank. Find the minimum cost for 
laying the cable. 

3. The company has decided to build a new factory that is located only 800 m downstream of the 

power plant. Using the lower costs of laying cable, find the optimal route for laying the cable. 
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Open the TI-Nspire™ document Exploring_Transformations.tns. 

 

In this activity, you will translate and reflect shapes in the coordinate 

plane. You will begin with a triangle with vertices A(1, 2), B(4, 7), and 

C(7, 3). 

 

 

Move to page 1.2. 

 

Press / ¢ and / ¡ to 

navigate through the lesson. 

1. Drag point H left and right to translate the triangle horizontally. Drag point V up and down to translate 

the triangle vertically. 

a. Identify the coordinates of points B′ and C′ if the triangle is translated 4 units to the 

left. How would you determine the coordinates mathematically? 

 

b. Identify the coordinates of points B′ and C′ if the triangle is translated 4 units to the 

left and 5 units down. How would you determine the coordinates mathematically? 

 

 

2. How must you translate ABC  for point B′ to have coordinates (3, 9)? 

 

 

3. Herschel moved point A to produce a new triangle. He then translated ABC  left 2 

units and down 5 units. 

a. Where would Herschel have placed point A to make the coordinates of point A′  

(–4, –3)? 

 

b. Explain how you can determine the coordinates of point A mathematically. 

 

 

Move to page 2.1. 

4. Reflect the triangle over the x-axis. 

a. Identify the coordinates of points B′ and C′ after the triangle is reflected over the  

x-axis.  

 

b. How would you determine the coordinates mathematically? 

 
 
 

114



  Exploring Transformations  Name   
 Student Activity Class    
 

©2011 Texas Instruments Incorporated 2 education.ti.com 

5. Reset the figure by moving the point back to the N position. Reflect the triangle over the y-axis. 

a. Identify the coordinates of points B′ and C′ after the triangle is reflected over the y-axis.  

 

b. How would you determine the coordinates mathematically? 

 

 

6. Describe how a reflection is different from a translation. 

 

 

7. Reset the figure by moving the point back to the N position. 

a. Predict the coordinates of points A′, B′, and C′ if the triangle is reflected over both 

the x-axis and the y-axis.  

 

b. Reflect the figure over both the x-axis and the y-axis and test your predictions. 

 

c. How would you determine the coordinates of A′, B′, and C′ mathematically? 

 

Move to page 3.1. 

8. Drag the points labeled V and H so that the L lies completely in Quadrant IV. What translations are 

needed so that the image of L lies completely in Quadrant IV?  

 

 

Move to page 4.1. 

9. Move the L to Quadrant IV by using the open circles in the upper-left corner of the screen. 

a. What transformations were necessary for the image of the L to appear in Quadrant 

IV? 

 

b. Does the order in which the L is reflected matter? Why or why not? 
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10. In the transformations on pages 3.1 and 4.1, why do you think that the letter L was 

used to illustrate the concept of transformations rather than the letter H? 

a. Justify your answer mathematically or with a sketch. 

 

 

 

 

 

 

 

 

b.  What other letters would be good choices to illustrate transformations using reflections? 

 

c. What letters are not good choices to illustrate transformations using reflections? Explain your 

answer. 
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Math Objectives 
 Students will identify the coordinates of a shape that has been 

translated. 

 Students will identify the coordinates of a shape that has been 

reflected. 

 Students will determine the original coordinates of a translated 

figure, given its current coordinates and the directed distance of 

translation. 

 Students will look for and make use of structure. (CCSS 

Mathematical Practice) 

 
Vocabulary 
 pre-image 

 image 

 transformation 

 translation 

 reflection 

 
About the Lesson 
 This lesson involves translating and reflecting shapes in the 

coordinate plane. 

 As a result students will: 

 Translate a shape horizontally and vertically by grabbing and 

moving points along a line 

 Determine the coordinates of the image given the amount of 

translation 

 Reflect a shape over the x-axis and the y-axis by moving 

points along a line 

 Determine the coordinates of the image given the direction of 

reflection 

 Determine the difference between a reflection and a translation 

 
TI-Nspire™ Navigator™ System 
 Use Quick Polls to check student understanding. 

 Use Screen Capture to examine patterns that emerge. 

 Use Live Presenter to engage and focus students. 

 Use Teacher Software to review student documents. 

 

TI-Nspire™ Technology Skills: 

 Download a TI-Nspire™ 

document 

 Open a document 

 Move between pages 

 Grab and drag a point 

 Switch from one application 

pane to another 

 

Tech Tips:  

 Make sure the font size on 

your TI-Nspire™ handhelds is 

set to Medium.  

 You can hide the function 

entry line by pressing 

/G. 

 

Lesson Materials: 
Student Activity 
Exploring_Transformations_ 
Student.pdf 
Exploring_Transformations_ 
Student.doc 
 
TI-Nspire™ document  
Exploring_Transformations.tns 

 

Visit www.geometrynspired.com 

for lesson updates and tech tip 

videos. 
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Discussion Points and Possible Answers 
 

 

 

Tech Tip: If students experience difficulty dragging a point, check to make 

sure that they have moved the arrow until it becomes a hand (÷) getting 

ready to grab the point. Press / a to grab the point and close the hand 

({). 

Note: Press / e to switch from one application to the other (left 

side/right side). 

 

 

Move to page 1.2. 

 

1. Drag point H left and right to translate the triangle horizontally. 

Drag point V up and down to translate the triangle vertically. 

 

a. Identify the coordinates of points B′ and C′ if the triangle is translated 4 units to the left. How 

would you determine the coordinates mathematically? 

 

Answer: The ordered pair for B′ is (0, 6), and the ordered pair for C′ is (3, 3). To determine the 

coordinates mathematically, subtract 4 from the x-coordinate in each ordered pair. 

 

b. Identify the coordinates of points B′ and C′ if the triangle is translated 4 units to the left and 

5 units down. How would you determine the coordinates mathematically? 

 

Answer: The ordered pair for B′ is (0, 1), and the ordered pair for C′ is (3, –2). To determine the 

coordinates mathematically, subtract 4 from the x-coordinate in each original ordered pair, and 

subtract 5 from the y-coordinate in each original ordered pair. 

 

2. How must you translate ABC  for point B′ to have coordinates (3, 9)? 

 

Answer: The triangle should be translated 1 unit to the left and 3 units up to produce 

the new coordinates for B′. 
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3. Herschel moved point A to produce a new triangle. He then translated ABC  left 2 units and 

down 5 units. 

a. Where would Herschel have placed point A to make the coordinates of point A′  

(–4, –3)? 

 

Answer: He would have placed point A at (–2, 2) for A′ to have the ordered pair of (–4, –3). 

 

Teacher Tip: Students can move point A to experiment in answering this 

question. (Point A' cannot be moved.) 
 

b. Explain how you can determine the coordinates of point A mathematically. 

 

Answer: Since Herschel translated A(x, y) left 2 and down 5, A' is given by the ordered pair  

(x – 2, y – 5). You can work backwards and find the x- and y-values by solving the equations  

x – 2 = –4 and y – 5 = –3. 

 

Teacher Tip: Students may mistakenly subtract the values of the shift from 

the x- and y-values of the coordinates of A'. You should help them 

understand that they are looking for the position of the original figure  

(pre-image) and must work backwards. 
 

TI-Nspire™ Navigator™ Opportunity: Open Response Quick Poll 

See Note 1 at the end of this lesson. 

 

Move to page 2.1. 

 

4. Reflect the triangle over the x-axis. 

a. Identify the coordinates of points B′ and C′ after the 

triangle is reflected over the x-axis. 

 

Answer: The ordered pair for B′ is (1, –2), and the ordered 

pair for C′ is (6, –4). 

 

b. How would you determine the coordinates mathematically? 

 

Answer: To determine the coordinates mathematically, find 

the opposite of the y-coordinate in each original ordered pair. 
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Teacher Tip: The open circles in the bottom left corner of the screen can 

be dragged left and right to reflect the triangle over the x- and y-axes. 

When the circle is dragged above the Y (for Yes), the triangle is reflected 

over the indicated axis. When the circle is dragged above the N (for No), 

the triangle is not reflected. 

 

The original triangle on page 2.1 has vertices A(3, 5), B(1, 2), and C(6, 4). 

 

5. Reset the figure by moving the point back to the N position. Reflect the triangle over the y-axis. 

a. Identify the coordinates of points B′ and C′ after the triangle is reflected over the y-axis. 

 

Answer: The ordered pair for B′ is (–1, 2) and the ordered pair for C′ is (–6, 4). 

 

b. How would you determine the coordinates mathematically? 

 

Answer: To determine the coordinates mathematically, find the opposite of the x-coordinate in 

each original ordered pair. 

 

6. Describe how a reflection is different from a translation. 

 

Answer: A reflection flips a shape over, while a translation slides a shape to a new 

location. 

 

TI-Nspire™ Navigator™ Opportunity: True/False Quick Poll 

See Note 2 at the end of this lesson. 

 

Teacher Tip: At this point, you may want to discuss that a translation 

preserves congruence and orientation of a figure, while a reflection 

preserves congruence but does not preserve orientation. 
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7. Reset the figure by moving the point back to the N position. 

a. Predict the coordinates of points A′, B′, and C′ if the triangle is reflected over both the x-axis 

and the y-axis. 

 

Answer: The ordered pair for A' will be (–3, –5), the ordered pair for B′ will be (–1, –2), and the 

ordered pair for C′ will be (–6, –4). 

 

b. Reflect the figure over both the x-axis and the y-axis and test your predictions. 

 

c. How would you determine the coordinates of A′, B′, and C′ mathematically? 

 

Answer: To determine the coordinates mathematically, find the opposite of the x- and y-

coordinates in each original ordered pair. 

 

Move to page 3.1. 

 

8. Drag the points labeled V and H so that the L lies completely 

in Quadrant IV. What translations are needed so that the 

image of L lies completely in Quadrant IV? 

 

Sample Answers: Answers may include moving to the right  

6 units and down 6 units, or down 6 units and then to the right  

6 units.  

 

 

TI-Nspire™ Navigator™ Opportunity: Screen Capture 

See Note 3 at the end of this lesson. 

 

 

Teacher Tip: Because the x- and y-axes are not in Quadrant IV, 

translating the image right 6 units and down 6 units works, but moving it 

right 5 and down 5 does not. Discuss with students that H and V are 

moving by integer values, but the transformations can be numbers other 

than integers. Make sure students understand that any number greater 

than 5 will work for either translation. 
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Move to page 4.1. 

 

9. Move the L to Quadrant IV by using the open circles in the 

upper-left corner of the screen. 

a. What transformations were necessary for the image of the 

L to appear in Quadrant IV? 

 

Sample Answers: The L could be reflected first over the x-axis and then the y-axis, or it could 

be reflected first over the y-axis and then over the x-axis. 

 

b. Does the order in which the L is reflected matter? Why or why not? 

 

Answer: The order in which the letter is reflected does not matter. For example, if a shape has 

an ordered pair of (3, 4) and it is reflected over the x-axis and then the y-axis, the resulting 

ordered pair is (–3, –4). If the same shape is reflected over the y-axis and then the x-axis, the 

resulting ordered pair is still (–3, –4). 

 

10. a. In the transformations on pages 3.1 and 4.1, why do you think that was the letter L was used 

to illustrate the concept of transformations rather than the letter H? Justify your answer 

mathematically or with a sketch. 

 

Answer: The letter H has two lines of symmetry and looks the same when it is reflected either 

horizontally or vertically. It is easier to see the results of a reflection with the letter L, which does 

not have a line of symmetry. 

 

b. What other letters would be good choices to illustrate transformations using reflections? 

 

Sample Answers: G, J, P, Q, R  

 

c. What letters are not good choices to illustrate transformations using reflections? Explain your 

answer. 

 

Answer: Any letter that has a line of symmetry would not be a good choice. For example:  

O, X, C, A, M. 

 

TI-Nspire™ Navigator™ Opportunity: Quick Poll 

See Note 4 at the end of this lesson. 
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Wrap Up 
Upon completion of the discussion, the teacher should ensure that students understand: 

 How to identify the coordinates of a shape that has been translated 

 How to identify the coordinates of a shape that has been reflected 

 How to determine the original location of a translated figure given its current location and the amount 

of translation 

 The difference between translations and reflections 

 

TI-Nspire™ Navigator™ 
Note 1 

Question 3, Open Response Quick Poll: Have students send their response to question 3a through an 

Open Response Quick Poll. If students have difficulty with the question, send the following Quick Poll 

after discussing question 3b:  

 

After the triangle is translated right 3 units and up 2 units, the coordinates of A′ are (–3, 5). What is the 

pre-image of A′?      

Answer: (–6, 3) 

 

Note 2 

Question 6, True/False Quick Poll: Send the following True/False Quick Poll: 

 

A reflection preserves orientation.  

Answer: False 

 

Note 3 

Question 8, Screen Capture: Use Screen Capture so that students can see multiple solutions to 

question 8. 

 

Note 4 

Question 10, Quick Poll: Have students send responses to questions 10b and 10c through Quick Poll. 

The visual representation of the letters in the students’ responses will help students “see” how many lines 

of symmetry each letter has, if any. 
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Activity Overview:  

In this activity, you will create a new self-check document with the Question application of the TI-Nspire™ 

Teacher Software. As you create this document, you will explore the properties of each of the four 

question types: Multiple Choice, Open Response, Equations, and Coordinate Points & Lists. Students can 

use this self-check document on their handhelds to answer questions and check their responses. 
 
 
 

Materials 

• TI-Nspire™ Teacher Software 
 
 
 
 

Step 1: 

Open the TI-Nspire™ Teacher Software. If the Welcome Screen appears when the software is opened, 
click  to create a new document with a Question application as the first page. Otherwise, insert a 

Question application by clicking Insert >  Question. 

 

Note: TI-Nspire™ documents with Question applications can be created only with TI-Nspire™ 
Teacher Software. Documents with Question applications cannot be created with the handheld 

or Student Software. Therefore, when the Teacher Software is in Handheld view and Menu is 

pressed, the Question application does not appear on the handheld screen or in  

TI-SmartView’s list of applications. 
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Step 2: 

The Choose Question Type window appears. 

Select Custom Choice and click Insert. 

 

Note: A brief description of the highlighted 

question type appears at the bottom of the 

window. 

 

 

Step 3: 

Enter the prompt given below. To type the equation 

into an Expression Box, go to the Documents 

Toolbox, select the  Document Tools pane, and 

select  Insert > Expression Box. 

 

Solve for x: 
9

32 212
5
x + =  

 

Note: An Expression Box can also be inserted by 
pressing /M. A variety of math 

templates can be accessed in the 

Documents Toolbox by selecting the 

 Utilities pane. 
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Step 4: 

Type the first answer choice into the first field by 

clicking it and inserting an Expression Box. To move 
to the next field, click in the next field or press ·. 

Type the following answer choices: 

x = 135
5

9
, x = 324 , x = 100 , x = 439

1

5
 

 

Note: To remove an empty answer field, click in 

that field and press the Backspace key. 

Step 5: 

As you type answer choices, they automatically appear 

in the Correct Answer fields in the Configuration 

panel. Select the correct answer by clicking the check 

mark in front of the answer choice. 

 

Note: In the Configuration panel, the Multiple 

Choice Properties can be changed to allow a 

different Response Type. Single Response 

allows for one correct answer, while Multiple 

Response allows for multiple correct answers. 

The Multiple Choice Properties and Correct 
Answer fields can be collapsed by clicking ¤ 
and expanded by clicking ¢. 
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Step 6: 

To allow students to check their answers, select  

 Teacher Tool Palette > Question Properties. Change the 

Document Type to Self-Check and click OK. 

 

Note: The Document Type applies to all questions in the 

current document. Therefore, all questions in the 

document will become Self-Check.  

 After students answer a question, they can check their answers by pressing b and 

selecting Check Answer. A message (“Your current answer is correct.” or “Your current 

answer is incorrect.”) is displayed. If the answer is incorrect, two options appear: Show 

Correct Answer and Try Again. 

 

Step 7: 

Insert a new question by clicking on the Insert menu and 

selecting  Question > Open Response > Text Match. 

Inserting an Expression Box for the equation, type the 

following into the question field: 

What is the slope of the line 2x ! 3y = 12 ? 

 

Step 8: 

Using an Expression Box, type 
2

3
into the Correct Answer 

field. To access math templates and symbols, click the  

 Utilities icon in the Correct Answer field. Double-click the 

Fraction template, and close the window by clicking Cancel. 

 

Note: The Explanation response type (not scored) allows 

students to give answers that closely match the 

correct answer. When students select Check 

Answer, the correct or incorrect answer message will 

not be displayed. However, any suggested response 

entered by the teacher will be displayed. 

The Text Match response type (scored) requires  

students to exactly match the correct answer, 

including templates (if applicable). When students 

select Check Answer, the correct or 

incorrect answer message will be displayed. 
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Step 9: 

Insert a new question by clicking the Insert menu and 

selecting  Question > Equation > y =. Type the following 

into the question field: 

Write the equation of a line whose slope is –2 and 

whose y-intercept is 3. 

 

Step 10: 

In the Configuration panel, choose Equation Properties 

and check the box for Include a Graph Preview. In the 

Correct Answer field, type –2x + 3 as an accepted 

response. 

 

Note: In the Configuration panel, the Equation 

Properties can be changed to allow Response 

Type in y = or f(x) = notation. The number of 

responses and prompt location can be changed, 

and students can be allowed to show their work in 

a series of blank fields. 

 

Note: By changing the Equation Properties 

to Include a Graph Preview, the 

page layout of the question is 

automatically changed and a Graphs 

application is inserted on the right. 

When an expression is typed into the 

y = field, it automatically appears on 
the graph. If · is pressed, another 

y = field appears. 
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Step 11: 

Insert a new question by clicking the Insert menu and 

selecting  Question > Coordinate Points & Lists > 

Drop Points. Type the following into the question field: 

Plot a point whose y-coordinate is twice its x-coordinate. 

 

Step 12: 

In the Correct Answer field, enter (1, 2) as an 

acceptable answer. Add an additional acceptable answer 

field by clicking the green addition icon. Enter (2, 4) as 

an acceptable answer.  

 

Note: The Drop Points question type 

automatically includes a Graphs 

application with a grid. 
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